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        Skycut Series D with SignCut Pro2 
 

July 3, 2020 
 

 
You can expect updates to this manual over the next few months  

 
 
Do NOT read this entire manual… unless you want to.   

• At the start of Chapters 1 - 4 are short sections with references to find what you need plus some important 
reminders.  PLEASE read these short sections at the very least and refer back to them, when needed. 

• Chapters 1 and 2 are very important in terms of correctly setting up your Skycut to work with SignCut Pro2 
and learning the ins and outs of cutting. 

• Chapter 3 is for those owners wanting to perform print and cut applications. 

• Chapter 4 covers using Skycut accessory tools and dual head applications. 

• Chapter 5 covers several SignCut Pro2 functions of interest: creating contour cuts and engraving fills.  

 
It’s not practical to print this entire manual because: 

• It’s a waste of paper and ink if you only ever need certain sections. 

• The live links to videos and web sites in the manual will not work. 

• This manual will be updated from time to time. 

• You cannot search on individual words. 

 
Also: 

• Videos of interest can be found at the following link:  Skycut Support Videos 
 

 

 

 

________________________________________________________________ 
 © 2018-2020  Sandy McCauley  All Rights Reserved 

https://www.iloveknk.com/support/skycut-videos/
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1. Introduction and Setting Up 
 
 

1.00 Quick Reference for This Chapter 

• How to download and set up SignCut Pro2:  Section 1.11 

• How to set up communication between a computer and Skycut: Section 1.12 

• How to use the control panel: Sections 1.10 and 1.14 

• How to adjust the blade holder: Section 1.07.3 

• Where to position the pinch wheels: Section 1.09 

• The cutting mat is too sticky (or not sticky enough): Section 1.08 

• How to use the USB Flash Drive feature: Section 1.12.4 

 

Important Notes: 

• Please read Section 1.02 regarding safe operation of the Skycut. 

• Report any damage or missing contents to your dealer promptly. 

• Retain the original box and packing materials in case you ever need to ship your Skycut. 

 

 

1.01 Support 

• Thank you for choosing a Skycut digital die cutter. Before using a blade in your new cutter, we urge you to 
read Chapters 1 and 2 and watch the videos linked in these chapters. 

• If you run into difficulties with the operation of your Skycut, turn off the power and look for a solution in this 
manual. Note that Appendix A is a Troubleshooting section.  If you continue to have technical questions or 
issues, please contact your dealer as soon as possible. 

• If anything is missing from your order or you have mechanical issues with your Skycut, please contact your 
dealer as soon as possible. You can also contact Skycut directly using this email address: 
skycut@skycut.cn.  

• For additional information and support with the Skycut, please check out the following: 

 Skycut web site: http://www.sky-cut.com/ 

 Skycut Facebook page: https://www.facebook.com/skycutcuttingplotter/ 

 Skycut Facebook group: https://www.facebook.com/groups/Skycut/ 

 Skycut YouTube channel: https://www.youtube.com/channel/UCrPn5hFLbiRNDgccY8iXwoA 

 SignCut User Guide: available in SignCut Draw (Help>User Guide) and in SignCut Pro (Help>Help) 

• For SignCut support, please go to https://signcut.freshdesk.com/support/home 
 
 
 

1.02 Safety and Warnings 

Please be aware of the following safety guidelines when working with the Skycut: 

• Pinch Points:  Keep hands, long hair, loose clothing, jewelry, etc. away from the moving parts. 

• Risk to Children and Pets:  Please supervise children around the cutter when it is in use.  

• Movement and Touching:  Do not move the Skycut or touch any circuitry while it is plugged in.  

https://www.facebook.com/skycutcuttingplotter/
https://www.facebook.com/groups/Skycut/
https://www.youtube.com/channel/UCrPn5hFLbiRNDgccY8iXwoA
https://signcut.freshdesk.com/support/home
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• DO NOT touch or jam the plotter’s track while it is operating. If the cutter is damaged, it is the owner’s 
responsibility. 

• DO NOT shake the cutter while it is operating. 

• DO NOT cut any materials that have staples or other embellishments attached. 

• DO NOT touch the cutter with a magnet. It is safe, however, to cut magnetic materials, such as those used 
on refrigerators and car exteriors. 

• DO NOT allow any liquids to spill into the cutter. 

• DO NOT allow small items to fall into the cutter. 

• Place the Skycut on a sturdy and stable table, desk, or trolley. The optional Skycut stand can also be used.  

• Always turn off the Skycut when not in use. Leaving the cutter turned on for extended periods of time can 
possibly damage the machine. 

• Always turn off the Skycut before unplugging or removing the power cable from the wall outlet or power 
strip. 

• Unplug the Skycut from a wall outlet or power strip during an electrical storm or when the cutter will not be 
used for an extended period of time. 

• Transporting: When transporting the cutter, move the pinch wheel lever into the upward position. Remove 
the blade from the blade holder and cover the tip with the plastic cap.  

 
 
 

1.03 Warranty 

• IMPORTANT! If your Skycut is damaged during shipment or appears to be defective, your dealer should be 
notified as soon as possible.  

• For additional information regarding your warranty, please refer to your Skycut dealer.  

• It is recommended that you retain the original box with packing materials in case you ever need to ship your 
Skycut. 

 
 
 
1.04 Unpacking 

• Verify that you have received all contents. There is a checklist in Section 1.05. Please notify your Skycut 
supplier immediately if anything is missing. 

• Remove all packaging before turning on the Skycut. Currently, the cutter ships with two end cap foam 
protectors, four plastic zip ties, and tape on either end of the cutting strip. Be very careful when removing 
the zip ties - only cut those ties and NOT the black cable behind them. Gently remove the tape at the ends 
of the cutting strip by rolling the tape away.  Do not pull straight up. 

• Because the cutting mat must be folded over to fit into the box, it may have become slightly rounded during 
shipping. Gently and only partially roll the mat in the opposite direction to remove the roundness and place 
on a flat table to make sure the mat now lies horizontally to the surface.  Refer to Section 1.08 for additional 
instructions on preparing the mat for use. 

• Use the enclosed test pen as you experiment and become familiar with operating the Skycut. Place scrap 
paper on the mat and simply draw shapes rather than cut them. This will prevent possible damage to the 
blade, mat, and cutting strip as you learn where shapes will cut and the basic operating procedures. 

 
 
 

1.05 Contents 

• Besides the cutter, your box should also contain the following items: 
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# Description Image Quantity

1 Power cable 1

2 USB Cable 1

3 60° Blade(blue cap) 1

4 45° Blade(red cap) 2

5 Blade Holder 2

6 Test Pen and 1 Refill 2 sets

7 Cutting Mat 1

 
 

 
 
1.06 Parts of the Skycut 
 

Front 
 
 
 

 
 

                      

• Alignment Markers: indicate to the user the available positions for the pinch wheels 

Alignment Marker 
 Pinch Wheel 

 
Control Panel 

Left  
End Cap 

Right 
End Cap 

Left-Side Blade Holder 
Seat (Left Jaw)  
 

Blade 
Carriage 

Ruler 

Cutting Strip 
(lt. gray) 

Grit Shaft (dk. 
gray and rough) 

Right-Side Blade Holder 
Seat (Right Jaw)  
 

Front 
Table 
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• Blade Carriage: moves the Blade Holder Seats left and right 

• Blade Holder Seats or Jaws (2 on D models): hold the blade holder, test pen, and other accessories 

• Control Panel: used to change settings, set up Wi-Fi, calibrate camera, cut PLT files, and more 

• Cutting Strip: protects a blade when cutting backed materials without using a cutting mat 

• Front Table: keeps cutting mat supported horizontally 

• Grit Shafts (5 on 24” model): allow the pinch wheels to grip the mat or material so they can be moved in and 
out of the cutter during cutting 

• Pinch Wheels (4 on 24” model): grip the mat or material so that the grit shafts beneath will feed the mat or 
material in and out during cutting 

• Ruler: for measuring and aligning rolled materials 

 
Right Side 

 
 

 
 
 
 
 

Left Side 
 

 
 
 
 
 
 

Back 
 

 
 

 
 

Reset 
Button USB Flash 

Drive Port 
USB Port 

Pinch Wheel Lever 
Pinch wheels 

Back Table 

• USB Flash Drive Port: used to load PLT 
files via control panel for cutting 

• USB Port: option to connect computer to 
Skycut with included USB cable 

• Reset Button: used to reset Skycut’s 
cutting buffer (does not reset calibrations) 

 

• Power Port: plug power cable into this port 

• On/Off Switch: power cutter on or off 
 

On/Off 
Switch 

Power Port 
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1.07 Accessories 
 

1.07.1 Tables (optional) 
 

• The following instructions are for the original table design. If the tables you purchase have brackets that are 

not part of the table, please watch this video:  

• While the two tables attach onto the cutter and do not require any support, you may prefer to not use them, 
especially if you are only cutting rolled materials. However, if you are using the cutting mat, the support they 
provide will keep the mat horizontal, thus reducing the chance of the mat drooping and causing materials to 
separate from the adhesive on the mat.  

• The screws required for attaching are already installed in the Skycut. They will be removed and then, after 
aligning the holes in the table, replaced to securely attach the table.  

• It’s much easier to install if you have a second person available to hold the tables in place while the screws 
are being inserted. It is also helpful to have a flashlight shining on the inside of the tables to better see the 
holes for alignment.   

• The two tables are identical. Start with either the front or the back of the cutter. 

• There are a number of screws mounted on the inside of the end caps. The ones to be removed are the 
second and third from the bottom. They are also the only two with washers: 

 
 

 

 

• Align the holes in the sides of the table with the holes in the end caps. Note in the following photos how the 
flat part of the table is on the outside: 

• Pinch Wheels (4 on 24” model): grip the mat or material so that the grit shafts beneath 
will feed the mat or material in and out during cutting 

• Pinch Wheel Lever: raises and lowers the pinch wheels 

• Back Table: keeps cutting mat supported horizontally 
 

Remove these two screws 
from right-side end cap 

Remove these two screws 
from left-side end cap 

https://vimeo.com/376972057
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• Insert the screws previously removed through the aligned holes and screw back into place. Then repeat on 
the other side of the cutter.  

 
 

1.07.2 Test Pen 
 

• The test pen should be used until you are comfortable with the operation of your Skycut and know, with 
certainty, where images will cut. The test pen should arrive pre-assembled. However, if you want to change 
out the insert to the red ink insert, note how the test pen is assembled:  

 
 

 
 
 
 
 
 

1.07.3 Skycut Blades 

• There are three kinds of blades that fit inside the Skycut blade holder:  

 

 

 The 450 red capped blade is suited for cutting thinner materials such as paper, all cardstock types, heat 
transfer vinyl, and wall/auto/decal vinyl.  

 The 600 blue capped blade is a much longer blade and is well-suited for cutting thicker materials, such 
as gum paste, craft plastic, craft foam, and rhinestone template material. 

 Sold separately is the 300 yellow capped blade. It is a wide blade and is well suited for cutting fabric, 
felt, and tint. It has been reported that it also works well with cardstock that has been exposed to 
humidity. 

 Red             Blue        Yellow 

Spring goes over the top of the pen insert 
and stops at a small ridge on the insert 

Flat part is on the outside 

Right side Left side 

These are the screws that are 
inserted through the holes in the 

table and into the end caps 
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• Note that the red capped blade and blue capped blade have a cutback on the opposing side of the blade 
(right side, in the earlier photo). This reduces the blade offset value and allows for better detailed cutting of 
small shapes.   

• Additionally, there are other tools sold separately, including a stand, an engraving tool and an 
embossing/scoring tool. Details on the engraving tool and embosser are covered in Chapter 4. 

 
 

1.07.4 Blade Installation  

• The blade must be carefully inserted into the blade holder.  Do this over a soft surface (e.g. over a hand 
towel). It’s important to protect the fragile blade!  To install, follow the numbered steps as shown: 

  

 

 

 

 

 

 

 

• The Blade Length (also called Blade Exposure) is how much blade is exposed at the bottom of the blade 
holder.  For optimal cutting, you want this length to match the thickness of the material or be just a tiny bit 
longer.  

• When setting the blade length (Step 4 in the prior photo), hold the blade holder up next to the material 
before pressing the material to the mat, so that you can more accurately set the length to match the 
thickness of the material. For really thin materials, like vinyl and thin paper, just the very tip of the blade will 
be protruding from the bottom of the blade holder. In fact, you should just barely be able to feel it with your 
fingertip and not be able to see it very well, if at all. Having the blade fully extended will never result in better 
cutting. In fact, it can cause skewing, tearing of the material, damage to the blade, and damage to the mat 
or cutting strip.  

• A good way to test your blade length is to fold a piece of the material onto itself and then cut a line into the 
material by hand. Press firmly but not too hard, as more force will not determine if the blade is set to the 
right length. If the blade cannot cut through the material, you will need to extend the blade. If the blade cuts 
through the material and cuts into the next layer, you need to retract the blade. If the blade cuts through the 
material but does not cut into the layer below, you have the perfect length.  

 

  

 

• When conducting a test cut, be sure to check your mat (or the top of a backing sheet) for cut lines after the 
test. You should be able to set the length to get clean cuts but with only fine lines or no lines in the mat or 
backing sheet. If you do see deep cut lines, retract the blade length ~¼ of a turn counterclockwise. Repeat 
your test cut. 

 
 

3. Turn the brass ring 
counterclockwise until 
loosened. 

4. Turn the large ring clockwise or counter 
clockwise to set blade length to match the 
thickness of the material being cut. 

5. Turn the brass ring clockwise 
until locked back in place. 

1. Push in this button 
and hold so that a blade 
can be inserted OR 
removed. 

2. Gently insert non-sharp end 
of the blade into the holder. 
An internal magnet will pull 
the blade inwards. 
 
Then release button on top of 
holder 

Mat 

Material 

 Perfect Length                 Too Long                            Too Short  
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1.08 Preparing and Caring for the Cutting Mat 
 

1.08.1 Tips on Using the Cutting Mat 

• Always use a mat to hold the material to be cut unless the material has its own protective backing. For 
example, vinyl and iron-on transfer both come with a layer that you do not cut. Thus, this backing layer 
serves as the carrier for cutting.  Paper and cardstock do not have a backing, thus they must be cut on the 
mat. 

• IMPORTANT!  A new mat may be too sticky if you are cutting certain products. This can cause difficulty in 
removing cut items without tearing. Place an old but clean bath towel over the surface of the mat and press 
with a brayer or rolling pin.  Then pull up. Test the stickiness by pressing the palm of your hand in the middle 
of the mat and lifting. If the mat remains stuck to your hand, repeat until the mat can still be lifted but will 
release. It should only take a few pressings to greatly reduce the stickiness, as tiny (too small to be visible) 
fibers from the towel are added to the surface. 

• Do not leave the pinch wheels in a down position when the Skycut isn’t in use. This warps the plastic 
sooner, shortening the useful life of the cutting mat.  

 
 

1.08.2 Cleaning and Replenishing the Cutting Mat 

• When mats begin to lose their stickiness, they can be washed: 

 Use a mild dishwashing detergent, warm water, and a soft brush to thoroughly clean the surface. You’re 
not trying to scrub the adhesive but just wet the invisible fibers that have been deposited from your 
cutting materials and get them released from the glue. 

o Rinse well, shake off excess water, and place sticky side down onto a bath towel.  

o Thoroughly dry the non-sticky side of the mat with another towel.  

o Pull the mat up and the sticky side should now be dry enough for immediate use. Test by making 
sure the mat will stick to your hand.  

• While washing with soap and water should revive the original adhesive, you can add more adhesive if 
necessary:  

 Virtually any repositionable adhesive may be used on the cutting mat. Some of the popular choices 
include: Krylon Easy Tack, Aleene's Tack It Over and Over (view the video at the start of this section), 
Crafter's Companion Stick and Spray, Zig 2 Way Glue with wide tip, Craft Smart Off 'N On, and Scotch 
Repositionable Craft Stick. There’s another spray adhesive, Scotch Super 77, which does not leave a 
sticky surface but is excellent for stabilizing paper and cardstock.  

 If you are cutting thicker materials, such as oil board or styrene, then you may want to experiment with a 
stronger adhesive and use painter’s tape to secure the material to the mat. If you are cutting thin paper, 
then you may want to experiment with a lighter adhesive.   

 With most repositionable adhesives, you can control the tackiness based on the amount applied. Thus, 
always add a little bit at a time.  As mentioned above, if you add too much, just apply a layer or two of 
cotton fibers by pressing with a bath towel.  

• Other reported methods for cleaning mats: 

 Use a plastic scraper (an old credit card will suffice) to scrape off any random material pieces remaining 
on the mat after a cut.   

 For finer particles of paper or lint, you can use a lint roller. Tear off a sheet and then press down and pull 
up across the surface of the mat to clean in sections. Baby wipes can accomplish the same task. 

 To completely remove adhesive from the mat, apply Goo Gone, Duck Adhesive Remover, or Avon’s Skin 
So Soft Bath Oil across the surface. Allow a minute to soak in and then scrape off with a sharp metal 
spatula. Repeat, as necessary until the mat is thoroughly clean and no longer sticky. Wash, dry and then 
add any repositionable adhesive.  
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• When necessary, the rubber wheels and the grit shafts may be cleaned with isopropyl alcohol or Un-Du. 
Apply the cleaner to a clean lint-free rag and rub the entire wheel and/or grit shaft until free of adhesive.  

 
 
 

1.09 Pinch Wheels 

• The pinch wheels can be raised and lowered using the pinch lever located at the back-right side of the 
machine. Press down on the lever and the pinch wheels will be raised. Pull the lever up to lower the pinch 
wheels so that they can grip the mat or the material inserted in the cutter. 

• There is also a small black lever on each individual pinch wheel. When the lever is raised, there is less 
downward pressure exerted. IMPORTANT: Only push these small levers down when an extra tight grip is 
needed, such as when cutting reflective film or thick chipboard. For normal cutting of most materials, it will 
not be required. 

  

• Note that for a pinch wheel to grip properly, it must be positioned over a grift shaft. To facilitate alignment, 
note the white rectangles positioned along the horizontal bar behind the blade carriage.  Slide the pinch 
wheels along the bar, as needed:  

 

• When using the cutting mat, it is recommended that the material be placed in the middle of the mat and the 
mat placed roughly in the middle of the cutter.  Then use the second and fourth pinch wheels locations for 
two pinch wheels. This keeps the pinch wheels off the material and provides an equal balance while the mat 
moves in and out during cutting: 

 

 

Wheels should be centered over grit 
shafts which are directly below the 
white rectangles 

Lever is in up position. 
This is recommended 
for most cutting. 
 Lever is in down position. Do 

NOT use this position except 
with certain materials.   

Middle two pinch wheels 
are placed under 2nd 
and 4th white rectangles 
 

Pinch wheels are approx. the 
same distance from the 
outside edges of the cutting 
mat   
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• Note that if your material is very wide, then it is fine to have the pinch wheels over the material. However, 
you may need to be extra careful when removing any cut shapes or waste material in those locations. 

 
 
 

1.10 Control Panel 

• When you first turn power on the Skycut, after several seconds, the following Main Screen or Home 
Screen will be displayed: 

 

 

• Throughout this manual, the functions above will be referenced along with submenus and additional 
screens.  You will also see the following icons at the bottom of many screens. Pressing the one on the left 
will always return you to the Main Screen above.  Pressing the one on the right will return you to the prior 
window/screen. 

 
 
 

1.10.1 Set Screen 

• Pressing the Set icon  opens the Set Screen which contains access to many functions and settings. 
Note the general description and section number (if you wish to learn more about that function now):  

 

 

Repeat last cut. While cutting, this icon and function changes to Pause.   

Open and cut PLT files from an 
inserted USB flash drive 

Execute a test cut using current 
speed and force settings 

Set the desired speed and force. 

Toggle the speed for moving the head and 
pinch rollers. In slow mode, the icon 

changes to:  

4 arrow keys for moving the 
head left/right and for moving 
the pinch rollers 

Stop and cancel the 
current cut 

Change settings 
Refer to 1.10.1 

Select which head to use 
or select Double Head 

Go back to Main 
Screen/Home Screen 
 

Go back to prior screen   

Set up wireless connection to home 
or office network: Section 1.12.2 

Version numbers, software 
selection, reset: Section 1.14.3 

Calibrate and use camera for print 
and cut applications: Chapter 3 

Array setup, Scale, and options for 
display and cutter behavior: Section 
1.14.2 

Set end-of-cut options: Section 
2.06  

Settings for: LED, Units, 
Language, Screensaver, Alarm: 
Section 1.14.2  
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1.11 Introduction to SignCut Pro 2 
 

1.11.1 Installing SignCut 

• SignCut Pro 2 can be downloaded from the following link: 

https://signcutpro.com/#download-section 

• In some cases, a virus protection software may warn users that there are potentially dangerous files. It is 
perfectly safe to install this program so temporary changes or disabling of your virus protection program may 
be required. After installing SignCut Pro 2, you can reestablish your virus protection.  

• The program can be used without purchase for three weeks, as long as SignCut2 has not been previously 
installed on that computer.  

• Note that three programs will be installed:  

 SignCut Pro 2 (the program you will use for cutting)  

 SignCut Draw (a program you can use for designing – PC version only)  

 SignCut Spooler (a program you can use for managing completed jobs).  

 You can also import a range of vector file formats into SignCut Pro 2 if you prefer to design in a different 
vector program. 

• Unlike prior versions of SignCut, license numbers are not used. For identification of your registration, an 
Alias name is used which appears in the Title Bar. To change your Alias: 

 Go to Account>My Account and click on My Signcut (left side).  

 You will then see an Edit Alias button to click which will open a window where you can enter a new 
Alias. Click on Save.  

 Close and reopen SignCut Pro 2. Your name Alias name should now appear in the Title Bar. 
 
 

1.11.2 Sign Cut Screens  

• The following screenshots provide labels for the various parts of SignCut Draw and Sign Cut Pro. It’s 
worthwhile noting the names of these parts as they will be referenced throughout this user manual.  

 

 

 

 

 

 

 

 

 

 

 

https://signcutpro.com/#download-section
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SignCut Draw: 

 

 

• Hovering your mouse over most of the screen icons will pop up the icon’s name and available shortcut.  

 While the shortcuts are shown with uppercase letters, use lowercase keys on your keyboard when 
executing. 

 On the Tools Panel, the shortcut keys (top to bottom) are in the same order as the alphanumeric keys 
on your keyboard (left to right: Q, W, E, R, T, Y, U, I, O, P, A, S). When needing to switch back and forth 
between any two tools, double-clicking an empty part of the Sign Area will toggle between the last two 
tools used. 

 Note that in some cases, as with functions on the Tools Panel, a shortcut key can be followed with a 
number to provide even faster access to a function plus one of its options on the Properties and 
Functions Bar. These shortcuts are written in this manual as, for example, E1, where you would press 
the “E” key, release, and then you would press the number “1”.   With other shortcuts, such as Ctrl+S, 
the “+” indicates you hold down the first key while pressing the next (i.e. hold the Ctrl key while pressing 
the S key). 

o Alternatively, you can repeatedly press one of the letters to cycle through the options for those 
particular tools. 

 Any shortcut with the letter “F”, such a F1, F2, F3, etc., refers to your keyboard’s function keys along the 
top.  

• In order to better remember where major elements are located, note that the term “bar” is used when 
components are laid out horizontally (such as the Toolbar) and the term “panel” is used when components 
are laid out vertically (such as the Tools Panel). 

• The Design Board refers to the entire white space available for placing shapes. The Sign Area refers to 
the portion inside the blue dashed lines. The Margin area is between the green dashed lines and the blue 
dashed lines.  

Menu Bar Toolbar Help Panel 

Color Palette  

Rulers 

Properties & Functions Bar 

Design Board Bar 

Tools 
Panel 

Design Board 

Shapes 

Filter Colors & 
Objects Panel 

Project Bar 

View Options 
Bar 

Status Bar 

Sign Area 

Margins 
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• Shapes are the objects or images that you will be adding to your projects. They can be created from scratch 
or imported from other sources.  

 
 

SignCut Pro2: 

               

  
 

• Hovering your mouse over most of the screen icons will pop up the icon’s name and available shortcut.  

• On the Main Panel, the shortcut keys (top to bottom) are in the same order as the top row of alphanumeric 
keys on your keyboard (left to right: Q, W, E, R, T, Y, U, I, O).  

• On the Sub-toolbars, the shortcut keys are in the same order as the bottom row of alphanumeric keys (left 
to right: Z, X, C, V, etc.).    

 
 
 

1.12 Connecting the Skycut to Your Computer 

• Place your Skycut on a sturdy horizontal surface. If using the cutting mat, be sure to allow enough free room 
in both the front and the back for the mat to extend during cutting. 

Menu Bar 

Top Toolbar 

Sub-toolbar – icons change depending on which tool is activated on the Main Panel  

Work Area 

Image 
Panel 

Main 
Panel 

Color 
Toolbar 

Help 
Window 

Tiles 
Panel 

Cutter 
Panel 
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• Powering On:  

 Plug the power cord into a wall outlet or power strip. Connect the power cord to the Skycut D on the left 
side end cap.  

 Turn on the power using the power button that is also on the left side end cap. After several seconds, 
the light inside the Skycut will turn on and the head will do a slight jog. 

• You have four options for sending files and information from your computer to the Skycut:  

 Direct USB using the included USB cable 

 Wi-Fi – adding the Skycut to a home/office network that is also accessed by your computer 

 Wireless Standalone – connecting wirelessly to your computer 

 U_Disk - Exporting PLT files from SignCut Pro2 onto a USB flash drive and then loading those files 
using the control panel on the Skycut.  

• Review the information in the following table to understand the differences between these options. Note that 
implementing any of these options does not preclude you from changing to another one, as needed. 

 

• The following sections present what steps are required for each type of connection. If you run into 
connectivity issues, please contact your dealer. 

 
 

1.12.1 USB Connection 

• Power on the Skycut and wait for the white light status. Connect the included USB cable into the Skycut’s 
USB port and into a USB port on your computer. 

• Open SignCutPro and click on the Cutter button near the top of the screen: 
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• The Cutter window will open. From each drop-down menu, select the Manufacturer, Cutter, and Output 
Device/Port as follows: 

 
 

• Click on Ok to close the Cutter window and proceed to Section 1.13. 
 
 

1.12.2 Wi-Fi Connection 

• Note: Not all routers have the same signal strength. It’s usually best to connect the Skycut while it is in the 
same room with the router.  Once connectivity is established, you can then experiment to see how far from 
the router the Skycut can be located.  

• What you’ll need: 

 Name of your home/office network 

 The password for your network 

• Carefully complete the following steps:   

(1) On the Skycut’s control panel, select Set   and then select Wifi. The Wifi screen will appear:  
 
 
 
 
 
 
 
 
 
 
 

Click on Cutter 

Look for any USB00X options in 
the drop-down menu. 
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(2) Click on the Scan button and a list of the available networks will appear. Select your home/office 
network and click on Apply. You will then be returned to the Wifi screen: 

                                    

(3) Click on Set and the following screen will open: 

 

 

Click on Scan  

 Click on Wifi  

 

Click on Set  

 

Select your 
network 

 

Click on Apply 

 

Delete last 
character 

 

Password will 
display here 

 

Click OK when done 

 

Toggle to switch between 
uppercase and 
lowercase letters 

 

Switch to punctuation 

 

Switch to 
numbers 
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(4) To enter the password, use the following tips if you are unfamiliar with this type of screen: 

 “Rapid tap” multiple times in succession to select a letter. For example, if your network password is 
cts456, then to enter “c”, you would tap three times on “abc” because “c” is the third letter in “abc”.  
Next you would proceed to “stu” and tap two times to enter “t”. Then you would only need to tap on 
“stu” once to enter the letter “s.”  

 To enter numbers, click on “123” to open the number entry screen. 

 For punctuation, click on “#@~“ to open the extra characters screen. 

 To enter upper case letters, click on the up arrow in the lower left part of the screen. 

(5) Once you have the password entered in the display box at the top, click on OK to return to the Wifi 
screen:  

 

(6) Next check the IP Address that will be assigned to the Skycut. The Skycut will automatically pick up the 
first three sets of digits from your router but will continue to display them as shown above. You only 
need to decide if the last set, which should be defaulting to “200”, can be used. Use the “+” or “-“ buttons 
to make any needed changes. 

(7) Click on Apply and wait for several minutes while your router assigns this IP Address to the Skycut. 
Eventually, you will see Connected OK appear: 

                                          

 

(8) If instead of receiving a Connected OK display, you see Password err, again verify the network you 
selected and the password you entered. If you are unable to successfully connect and the Skycut is 
within a few feet of your router, please check your router’s user manual and/or search online for issues 
with your particular router model.  

(9) If you wish to reset and start again, press and hold the Default button for 3 seconds until the button 
turns red. Then click on Scan and repeat from Step 3. 

Default IP Address 
assigned to Skycut 

 

Click on “+” or “-“ buttons to 
change IP Address, if needed 

 

Success! Click on Apply 

 
Click on Apply 

 
Wait will be displayed for 

several minutes 
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(10)  Once you receive the Connected OK display, open SignCut Pro and click on the Cutter button near 
the top of the screen: 

 

 

• The Cutter window will open. From the drop-down menus, select the Manufacturer and Cutter as shown: 

 

• In the drop-down menu for Output Device/Port, select TCP/IP and a new window will open. In that window, 
enter the same IP Address you selected earlier on the Skycut’s control panel. Also, enter 8080 for the Port 
assignment: 

 

 

• Click on Ok to close the TCP/IP window and Ok again to close the Cutter window. Proceed to Section 1.13. 

 
 

1.12.3 Wireless Stand-Alone 

• It’s usually best to connect the Skycut while it is next to the wireless computer.  Once connectivity is 
established, you can then experiment to see how far from the computer the Skycut can be located.  

• There are two situations to consider before getting started. If you are not sure which applies to your Skycut, 
then select B and go to that section first.  

A. The Skycut has never been set up wirelessly to a network. 

B. The Skycut has previously been connected to a wireless network.  

Click on Cutter 

Enter the IP Address 
from earlier setup 

Select TCP/IP 

Change Port to 8080 



 23 

 

A. The Skycut has never been set up wirelessly to a network 

• Power on the Skycut and wait for the light to come on. 

• On your computer, open your list of available networks. In the list, you should see one with this type of name 
format:  HI_LINK_XXXX where “XXXX” can be any alphanumeric combination, such as “92BF” or “08A5”.  

• Select that network and enter the following Network Key when prompted: 12345678. 

• In SignCut Pro, click on the Cutter button near the top of the screen: 

 

 

• The Cutter window will open. From the drop-down menus, select the Manufacturer and Cutter as shown: 

 

• In the drop-down menu for Output Device/Port, select TCP/IP and a new window will open. In that window, 
enter 192.168.16.254 as the IP Address. Also, enter 8080 for the Port assignment: 

 

 

• Click on Ok to close the TCP/IP window and Ok again to close the Cutter window. Proceed to Section 1.13. 

 

 

 

Enter this IP Address  

Select TCP/IP 

Change Port to 8080 

Click on Cutter 
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B. The Skycut has previously been connected to a network 

• On the Skycut’s control panel, select Set   and then select Wifi. The Wifi screen will appear:  
 

                           

• To reset the Skycut so that it will be found as an available network, press and hold the Default button for 3 
seconds. Release and you should see the Apply button now displaying Wait. In a minute the Apply should 
return and you can then proceed back to A. The Skycut has never been set up wirelessly to a network and 
use the same procedure as if the Skycut was never set up on a network. 

 
 

1.12.4 USB Flash Drive 

• With a USB Flash Drive connection, you will normally follow the steps presented in this section. If you are 
new to SignCut Pro and/or to your Skycut, it is recommended that you go to Section 1.13 now and set up a 
test file using the steps presented there. In that section you will be instructed when to return here to 
complete the steps needed to export your file onto a flash drive.  

• Insert a USB flash drive into your computer and allow your computer to find it. Note the drive letter assigned. 

• If you plan to primarily use the USB flash drive option, complete this next subsection to make it the default 
connection setting in SignCut Pro. Otherwise, skip to the subsection called Exporting a File as PLT.  

Setting the USB Flash Drive as the default connection 

• Click on the Cutter button near the top of the screen 

 

 

• The Cutter window will open. From each drop-down menu, select the Manufacturer, Cutter, and Output 
Device/Port as follows: 

Press and hold 
Default 

 

Click on Wifi  

 

Click on Cutter 
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• Click on OK to close this window. 
 

Exporting a file as a PLT 

• To export/save the cut file as a PLT on a flash drive do one of the following: 

 If you set up Write to file as the default, then click on the Cut out icon (or use the shortcut I) 

 If your default is a different connection, but you wish to use Write to file in this case, hold the Shift key 

and click on the Cut out icon  

• The following window opens. Browse to locate the USB flash drive you plan to use and name your PLT file: 

 

 

• After saving the file, eject the flash drive and insert it into the USB port on the right side of the Skycut. On 
the control panel, select USB and then Open File:  

 

 

 

 

 

 

 

 

 

 

Locate the USB flash 
drive for saving your files 

Enter a file name 

Click on Save 
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(1) Double tap on USB DISK and a screen will open showing any folders and PLT files on the flash drive. 
Double tap a folder to open it, as needed.  Drag the scroll bar on the right to see more files:  

           

 

(2) Once you have located the PLT file you want to cut, double tap the name. You will be taken back to the 
USB screen and the selected file name will be displayed: 

     

 

Drag here to scroll 

 

Double tap here 

 

Double tap on 
selected file to go 
back to USB screen 

 

Press Open File  

Set up repeats, refer to 
Section 1.14.1  

Click here and 
cutting will begin 
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(3) If you wish to cut repeats of the file, select Array Set and a screen will open where you can then select 
the number of rows and columns of repeats, along with the spacing between the repeats. Refer to 
Section 1.14.1.  

(4) If your project is a print and cut (aka contour cut) application, please refer to Section 3.07.  

(5) When you are ready to cut, click on Start Cut.   
 
 
 

1.13 Test Draw Shapes 

• New owners tend to be VERY eager to try out their Skycut. It’s important to test your cutter to ensure that 
data is being sent properly from your computer to the cutter. The following steps will allow you to do some 
testing with the pen tool. But note that the following steps are for DRAWING, not cutting.  Before 
inserting the blade holder into your cutter, please read the following Sections 1.07.2, 1.07.3, 2.01-2.03. 

 

1.13.1 Inserting the Paper and Setting the Origin 

• You have two options when using the test pen:  

 Insert a sheet of paper directly into the cutter. Make sure the paper is past the ruler so that it doesn’t 
catch when feeding the paper forward: 

 

 Or…Place the paper onto the cutting mat and then insert the cutting mat into the cutter:  

 

Observe how pinch 
wheels are centered with 
white rectangles 

 

Observe how pinch 
wheels are centered with 
white rectangles 
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• Use any of the horizontal markings at the front of the Skycut (such as the ruler) to align the mat so that it’s 
straight. Lift the pinch lever to drop the pinch wheels onto the cutting mat. Most of the mat and the paper 
should now be behind the cutter, not in the front. 

• Before installing the test pen, make sure the pen will write by scribbling on scrap paper. Note that you will 
probably need to remove a tiny bit of wax on the end of the pen nib. Then follow these steps: 

 Loosen the screw on the left-side blade holder seat, which is considered the “default” side. 

 Insert the blade holder allowing it to freely rest on top of the paper.  

 Before tightening the front screw, raise the test pen up a little bit (~ 1/8” or several mm).  You don’t want 
the pen still touching the paper but you also don’t want the pen too high above the paper either. 

 Tighten the front screw to lock in the test pen. Be careful not to push down on the blade holder seat 
while tightening.  

 

 

• The arrow keys on the Skycut’s control panel will always be used to set the origin for cutting: 

 

 Click on the buttons or the arrow keys on your keyboard to move the head left or right and the mat in 
and out. The goal is to have the tip of the pen close to the lower right corner of the paper: 

 

Only the front part of the 
mat and material will be 
in the front of the 
machine. 

 

Feed the mat this 
direction into the 
Skycut 

Align the paper along 
one of the grid lines on 
the cutting mat. 

The middle button can be 
toggled, if needed, so that 
the movement is much 
slower. 

Use these arrows to move 
the mat in and out and 
move the head left and 
right 

Press this green circle so 
that the left head will be 
used 

IMPORTANT!  This is NOT the recommended method for loading the blade holder into the cutter. 
This is presented as a quick way to insert the test pen so that it is in a good position for drawing. 
The instructions for inserting the blade holder will be covered in Section 2.01.3. 
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 Once the pen tip is near the lower right corner, you are ready to proceed with the test.  
 

1.13.2 Default Settings in SignCut Pro 

• Before creating a test shape in SignCut Draw, there are several settings to verify in SignCut Pro so that your 
results will match what is shown in this and other tutorials: 

 Shapes can always be rotated before cutting.  However, you may have a personal preference regarding 
how projects transferred from SignCut Draw appear upon opening in SignCut Pro.  To set this, go to 
Settings>Settings (in SignCut Pro) and select the Default Folders icon. Mark or unmark the Rotate 
image 90 degrees setting, as desired. For now, this tutorial will leave this setting unmarked:  

     

 Another setting to verify before proceeding with the testing and all subsequent cutting is to verify that 
the correct rotation is set for your Skycut. To do this, go to Cutter>Settings and click on the Advanced 
settings tab. Verify the Rotate setting is set to 90 deg: 

 

 

Move pen tip 
to this corner 
of the paper. 

Move the pen tip 
to this corner of 
the paper 

Feed the mat this 
direction into the 

Skycut 

Select Default 

folders 

Uncheck the 

Rotate option 

Click on Ok 
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 The third setting is at the top of the Color toolbar on the right side of the screen. This tutorial will cover 
both options but, for now, click the top icon to the Whole Area setting (if needed) so that it looks like the 
one in the following screenshot. Note that the icon below it controls whether closed shapes display filled 
or in wireframe mode. Either option for this setting is fine since it does not affect where the shapes draw 
or cut: 

 
 
 

1.13.3 Adding a Test Shape to Draw 

• Open SignCut Draw and, on the left side Tools panel, click on the Sign Setup icon  or press the 
shortcut key W.  In the Properties & Functions Bar above the Sign Area, you will see the following: 

 

• Mark the Size option and other settings will appear.  From the Presets menu, select Letter or A4 or 
whatever size of paper you are using for testing. Set the Margins to 0. Click on the checkmark icon to 
Apply: 

 

 

• On the left side Tools panel, click on the Shape tool icon  or press the shortcut key Y.  

• In the Properites & Functions Bar at the top there will now be an assortment of shapes from which to 
select. The arrow is the best choice because it’s important to learn the orientation of shapes on the screen 

Change to Size 

 
Click on checkmark 
to Apply 

 

Select a Preset 

 

Set Margins to 0 

 

Set to 90 deg 

Click on Advanced settings 

Click on Ok 

Set to this icon 

 
Toggle between wireframe 
and filled, as desired 
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relative to where they will be drawn/cut by the Skycut before you begin cutting actual projects. Click on the 
Arrow option:  

 

• Left click once in the Sign Area and then move the cursor towards the right and down to create an arrow 
which points towards the right. Left click again to complete the arrow:  

  

• If you wish to resize the arrow, drag any of the square handles around the selected arrow. On the 
Properties & Functions Bar, the Height and Width of the arrow will be displayed: 

  

• Alternatively, you can enter new measurements into those fields, if you wish. Uncheck the Proportional 
option if you want to separately change Width and Height. When done, click on Apply: 

 

 

• To position the arrow, drag it to any location within the Sign Area boundaries. Note that if you are still in the 
Shape tool mode, you’ll need to drag the shape by having your mouse cursor on the center X.  Otherwise in 
Object edit mode, you can drag anywhere within the shape: 

 

• To send this arrow to SignCut Pro for drawing, click on the Move Image to SignCut icon  (bottommost 
icon) on the Tools panel or press the shortcut key S. 

• SignCut Pro will open and the arrow will be displayed: 

Menu of available basic shapes 

 
Select the Arrow 

 

Height and Width 

 

Enter new values 
as desired 

 

In Shape tool mode , 
drag the small X in the 
center 

 

In Object edit mode , drag 
anywhere with the shape 

 

Uncheck the Proportional option 

 

Click on Apply 
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1.13.4 Drawing the Shape from SignCut Pro 

• Click on the Cut Out icon  (second from bottom) on the Tools panel. The following window opens: 

 

• A few items to note about this window: 

 The top right portion of the window shows a preview of the arrow and the orientation in which it will be 
drawn relative to the origin you set on the Skycut (which is represented by the blade holder image. In 
this case the arrow will be pointing upwards as you face the Skycut. 

 As a reminder of the orientation, the image of a cutter below the preview will remind you that the top of 
the preview corresponds to the left side of the cutter and the bottom of the preview corresponds to the 
right side of the cutter (as you face the cutter).  

 There is a weed border option that is probably checked by default.  Since this is a test draw, turn off the 
weed border by unchecking the Use weeding frame option: 

 

 

 

Or… 

 

Wireframe mode 

 
Filled mode 

This is a weed border around the shape  

This is the front right corner where 
you set the origin. The arrow will 
be drawn away from you.  

This image of a cutter indicates how 
the preview above is oriented.   
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• Click on the Tool settings tab. The following window opens where you can enter the settings for drawing 
with the test pen. Note that with the Skycut, you also have the option to enter settings on the control panel 
instead. 

    

• At this point, if you plan to export this file to a USB flash drive, rather than cut directly to the Skycut from 
SignCut Pro, please go to Section 1.12.4 for instructions.  Otherwise, click on Cut out and the Skycut will 
draw the arrow on your paper: 

 

Uncheck Use weeding frame 
to remove outside rectangle 

Check this box if you want to enter the 
Cutting force and Cutting speed to be 
used in SignCut versus on the control 
panel 

Select Tool settings tab 
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• You’ll note that the arrow is drawn in the same location as it was positioned in the Work Area. Often, 
however, users will prefer to save on material and have shapes cut as close as possible to the origin set on 
the material. To do this, click on the top icon on the right-side Color toolbar to switch from Whole area 
mode to Optimized mode: 

    

• You’ll note that the shape now fills the Work Area boundary. However, the arrow is still the same size. It’s 
just been enlarged on the screen the new Work Area is the bounding box around that shape instead of the 
Letter size originally selected in SignCut Draw: 

 

• Click on the Cut out icon and you’ll observe that the boundary around the shape is now aligned with the 
origin: 

    

 

• Draw with this setting and the arrow is now moved to the origin: 

Feed the mat this 
direction into the 
Skycut 

The arrow is drawn in the same 
location as in the Work Area 
and points upwards  

 

Click on this icon 

 

This icon indicates 
Optimized mode 

Corner of bounding box around 
shape is now aligned with the origin 
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• If you want the arrow to draw so that it points towards the left instead of upwards, click once on the Rotate 

90 degrees icon  on the Sub-toolbar at the bottom of the screen. The main screen, cut preview and 
resulting drawing of the arrow will result in this: 

           

 

• Subsequent clicks of the Rotate 90 degrees icon will continue to rotate the arrow. Continue practicing with 
this and other shapes until you feel confident you understand the correlation between what you see on the 
screen and what actually gets drawn. Also, refer to Section 2.02.2 for more details on controlling where 
images will cut. 

 
 
 
 
 

IMPORTANT:  Please read Section 2.01 before cutting! 

Feed the mat this 
direction into the 
Skycut 

The arrow is drawn at the origin 
and points to upwards 

 

Click here to rotate 
The arrow is drawn at the origin 
and now points to the left 

 

The preview indicates 
the arrow is rotated 
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1.14 Default Settings To Consider 

• The Skycut’s control panel offers a number of default settings. Some of these may not be important at this 
point in the learning process. So, you may want to skip this section for now but remember that it’s here and 
could provide you some options to improve your experience with the Skycut. 

• Each of the following sections will refer to one of the settings in the Set screen. 
 

1.14.1 Advanced Settings 

• The optional settings in the Advanced Settings screen are: 

 
 

• Array: Tap the Array button to open the Array screen: 

     

 In the above screenshot, the shape sent to the Skycut would cut 3 across and 7 up & down, for a total of 
21 shapes. The spacing between each shape would be 0.20 inches (Note: to use mm instead of inches, 
switch the Units setting. Refer to Section 1.14.2). 

• Show Point: When toggled on, the Main Screen displays movement and location output based on the 
position of the cutting head: 

Display (X,Y) location of cutting 
head 

Option to change back to 
single head only 

Set up rows & columns of repeats 

Turn on if you want cutting head 
to move to the far right when 
cutter is powered on 

Separate Cut Speed from Up 
Speed  

Option to change directions on 
up/down keys  

Sizing Calibration 
Refer to Section 2.08 

Tap here to turn on Array      

Spacing between left-to-right repeats 

Number of repeats: left to right 

Number of repeats: up & down 

Spacing between up-&-down repeats 

Repeats for a print and cut application 
Refer to Section 3.08     
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 Absolute Location displays the current location relative to a “power-on” location of (0,0):  

o X is the left-to-right location 

o Y is the up-&-down location 

o L is the straight-line distance from (0,0) 

 Relative location displays the change in location currently being made as you press the arrow keys: 

o x is the current left-to-right distance moved from X  

o y is the current up-&-down distance moved from Y 

o l is the straight-line distance from the (X,Y) location 

• Up Speed is how fast the blade travels while in the “up” position, such as when it is moving from the origin 
to the location of the first shape to cut or when moving from one cut shape to begin cutting another. When 
turned off, Up Speed will match the SPEED set for cutting. Turning on this setting will change the 
Speed/Force screen to display both speeds, allowing them to have different settings: 

  

                     

• To right power on: With this setting turned on, the cutting head will move to the far right whenever the 
Skycut is powered on.  

• Y Key Mode: This setting controls the movement of the material or cutting mat when using the up and down 
arrows in the Main Screen: 

As arrow keys are tapped, all locations 
will update 

Absolute Location Relative Location 

Speed control for arrows buttons is 
located here when Show Point is on. 
Press to toggle to slow speed when 

needed:  

Press here to reset 
Relative Location  

Cut Speed 

Up Speed 

Head Selection 

Force  
Force  

Cut and Up 
Speed 

Head Selection 
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• System Mode is used to select whether or not the dual head options are available on the main screen: 

 

• Scale is used is used to input the sizing calibration. Refer to Section 2.08.  
 
 

1.14.2 General Settings 

• The optional settings in the General Settings screen are: 

 

Pressing an UP arrow will move 
the material forward  
 
Pressing a DOWN arrow will 
move material towards the back 
of the cutter 

Pressing an UP arrow will move the 
material towards the back of the 
cutter 
 
Pressing a DOWN arrow will move 
material forward 

Normal cutting/drawingwith just a 
blade holder or test pen on the 
left side 

Option to use both heads 

Select blackout time for 
screens and end-of-cut alarm 

Set preferred lighting intensity 

Select preferred language for 
control panel 

Select inches or millimeters 
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• LED set allows you to change the brightness of the light inside the Skycut or even turn it off:  

 

• Screen and alarm has two settings: 

 Screensaver time: Set a black-out time, in minutes, for the control panel  

 Alarm after finish working: When a job is complete, have an alarm sound (five beeps)  

 

 

• Unit allows you to choose either inches or mm for settings such as Show Point and the Spacing setting 
under Array.  

 

Drag to change the intensity 
of the light 

Turn off light 

Increase Screensaver time (or 
drag the orange bar) 

Decrease Screensaver time 
(or drag the orange bar) 

Turn on Alarm to beep at end of 
cut  
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• Language allows you to choose from eight languages to be used throughout the control panel display 
screens: 

 

1.14.3 Sys Information 

• The Sys Information screen displays information about the Skycut and only has three setting changes 
available:  

 

 This initial screen displays current version numbers.  

 If you ever need to reset your Skycut, press and hold Default All until it turns red. Then wait for the 
button to update to Success! 

 If you ever need to change which software is in use with your Skycut, press and hold SOFT for two 
seconds and release. The following screen will open: 

 

Press and hold to open 
Software Screen 

Model ID’s and version 
numbers 

BAUD setting based on 
software selected  

Press and hold to reset Skycut 

Software options 

BAUD setting based on 
software selected  
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 To use a different software program to cut to the Skycut, press inside the appropriate circle. The Baud 
Rate indicator will automatically change if needed. Note: There is no longer a difference between the 
Flexi/Signcut option and the Signmaster/SCAL option, thus no need to change when using SignCut 
Pro. 

 
 

1.15 Maintenance 

Skycut machines do not require any kind of lubrication or routine checks. However, here are a few things to 
keep in mind for successful operation of your cutter: 

• Keep the pinch wheels clean. Depending on the adhesive being used on the cutting mat, it’s possible for the 
pinch wheels to become sticky and pick up small pieces of cardstock or other material being cut. This can 
lead, in some cases, to the mat skewing or ruining materials during subsequent cuts. To clean the pinch 
wheels, use a lint-free cloth and an adhesive remover such as isopropyl alcohol or Un-Du to clean the pinch 
wheels thoroughly. 

• Keep the grit shafts clean. Equally important as the pinch wheels, the grift shafts beneath the cutting mat 
should also be free of adhesive and tiny bits of material. They can be cleaned the same way as the pinch 
wheels. Note: Do not pour cleaner onto a grit shaft. Instead, dab some adhesive remover onto a lint-free 
cloth and then use the damp cloth to clean the shafts.  You can also use tweezers to remove any material or 
adhesive that is stuck to a shaft. 

• Keep the cutting mat clean and sticky. As mentioned in the Section 1.08.2, the cutting mat can be washed 
with soap and water to remove small invisible pieces of material which are reducing the tackiness of the 
cutting mat. After drying, you can add more repositionable adhesive, if needed. 

• Check your blade holder, as needed. If suddenly you cannot get a clean cut, check the blade holder for any 
tiny slivers of material that may have been caught up by the blade and fed up inside the blade holder.  

• If you cut vinyl or other backed materials regularly, you may need to replace the cutting strip at some point. 
You will be able to tell based on seeing deep cuts in the strip and an inconsistency in the cutting. Contact 
your dealer for information on obtaining a replacement. 

 
 
 

1.16 Other Useful Tools and Supplies 

• The following list has items you may or may not need while enjoying your Skycut. These are suggestions 
based on twelve years of collecting information from other cutter owners: 

 Brayer or Rolling Pin: (1) to apply lint from a towel onto an overly sticky mat  (2) to press materials 
evenly onto a mat for cutting 

 Post-It Notes: (1) for setting blade/tool tip height above a material  (2) for draw and cut applications   

 Old Fluffy Bath Towel: (1) to dry a washed mat  (2) to apply an invisible layer of lint onto an overly-
sticky mat 

 Dishwashing Soap: (1) to remove visible and invisible fibers from the mat, thus renewing the adhesive 
(2) to clean the mat well before adding more adhesive 

 Soft Brush: (1) to gently remove waste scraps during the washing of a mat. Refer to Section 1.08.2. 

 Artist Palette Knife: (1) to gently remove cut shapes from a mat  (2) to scrape off small waste pieces 
from a mat  

 Blue Painter’s Tape: (1) to tape around the edges of thicker materials that might slip during cutting 

 Repositionable Adhesives: (1) to add more adhesive to a cutting mat (most any brand or type can be 
used, provided it is repositionable). Refer to Section 1.08.2 for suggestions and instructions. 

 Adhesive Removers: (1) to completely strip a cutting mat of adhesive (2) to disarm adhesive long 
enough to remove large scraps of material that will not peel off 

 Lint-free Cloth: (1) for dusting off your cutter and cleaning pinch wheels and grit shafts 
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 Awl or Paper Piercer (or other sharp pointed tool): (1) to pick or lift out a test cut to verify results 

 Stabilizers: A stabilizer is an adhesive material that is applied to the bottom of the material you are 
cutting so that cleaner cuts can be achieved. The stabilizer works in one or more of the following ways – 
(1) provides firmer contact with the cutting mat (2) provides a final layer that does not need to be cut if 
the stabilizer will be removed after cutting (3) prevent some slightly-elastic materials from being 
stretched by the blade.  Recommended stabilizers include freezer paper, Thermo-web Heat n’ Bond, 
and Steam-a-Seam 2. 

 Double-sided Tape: (1) For securing metal tags or charms to the cutting mat for engraving 

 Non-slip Shelf Liner: (1) To place under cardstock and other material when embossing 
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2. Cutting 

 
 
 

2.00 Quick Reference for this Chapter 

• How to properly mount the blade holder: Section 2.01.3 

• How to control which shapes get cut: Section 2.02.1 

• How to control where shapes get cut: Section 2.02.2 

• Understanding Blade Offset and Overcut: Section 2.03.3 and Section 2.03.4 

• How to set a very precise origin: Section 2.05.1 

• How to add weeding lines to a cut: Section 2.06.3 

• Checklist before cutting: Section 2.07 

• How to get shapes to cut to precise dimensions: Section 2.08 

• How to know which settings to adjust to solve cutting issues: Section 2.09 

 

The Most Common New Owner Mistakes: 

• Too much blade is exposed on the blade holder (material is lifting up and/or tearing) - refer back to Section 
1.07.3 

• The blade holder or test pen haven’t been properly mounted - refer to Section 2.01.3 

• The pinch wheels are not properly positioned (material or mat is sliding around or bunching up during the 
cut) – refer back to Section 1.09 

• Failing to do a test cut (recommended cut settings are not working) – refer to Section 2.01.5 and 2.09 

• Not practicing enough with the test pen and paper (shapes are not cutting in the correct locations) – refer to 
Section 2.02.2 

 
 

2.01 What You Need to Understand About Cutting 
 

2.01.1 You Have To Make Mistakes 

• The key to becoming successful at cutting is to do a lot of it. Those who shy away from using their Skycut 
will never get to the stage of mastering it.  It’s very normal for new owners to be intimidated by their cutter, 
so remember the following key things: 

 You won’t break your new Skycut by cutting paper, vinyl, cardstock, and other easy-to-cut materials.  
The worst thing that might possibly happen is that you’ll break a blade. That’s it!  And the likelihood of 
even that happening is low. 

 You need to start cutting so that you’ll begin making mistakes! It’s in making these mistakes that you 
start to learn. You realize that these mistakes didn’t result in a broken cutter.  Plus, you’ll stop making 
the same mistakes as you remember more of the things you need to check before every cut.  

 As you make fewer mistakes you begin to build confidence and you begin to have more cutting success. 
From there, you begin to experiment more and produce more. Thus, your best course of action is to just 
start cutting… a lot! But first, read the rest of this chapter. 

 
 
 
 

IMPORTANT:  Please read all of 2.01!!! 
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2.01.2 Record Your Successes 

• As you have successful cuts, take note of the settings you just used, such as Force, Speed, blade type, 
number of passes, brand of material, etc. There is a blank form in Section 2.10 that you can print and use to 
record your results.  There are also suggested settings for common materials at the end of this chapter. Use 
these as starting guides but remember that your results may vary based on the many factors which can 
affect cutting. 

 

2.01.3 Installing the Blade Holder, Test Pen, or Accessory Tools    

• The gold blade holder has a rim around the outside that will, when cutting most materials, rest on the silver 
part of the blade holder seat.  When inserting the blade holder, loosen the front screw and then grasp the 
top and the bottom of the black piece and move back a bit while inserting the blade holder. The blade holder 
should then drop down so that the rim is below the black top piece of the blade holder seat: 

 

• The Blade Height is the distance from the tip of the blade to the top of the material you are about to cut. 
Thus, in the photo above, you can see that there are several millimeters of Blade Height which is important 
for two reasons: 

 You do not want the blade dragging across the material when the blade holder is moving from the origin 
to the first shape to cut (or between shapes). 

 More force is applied when there is a drop distance for the blade holder to start cutting. This is also 
referred to as “punch room” and provides more consistent cutting across the width of the machine.  

• When cutting a very thick material, such as 2 mm craft foam, it is recommended that the rim on the blade 
holder be resting on top of the black piece: 

 

• When using the test pen or an accessory tool without a rim, you’ll need to insert the tool using a spacer on 
top of the material.  A stack of 35 Post-It notes or 35 sheets of regular copy paper work well.   

 The recommended method for loading the test pen or another accessory: 

o Place the spacer on top of the material, with the material loaded into the Skycut.  

o Loosen the screw on the blade holder seat and insert the tool so that the tip of the tool is touching 
the top of the spacer: 

Rim of blade holder is resting 
on the silver part of the blade 
holder seat 
 

With the front screw loose, the 
black piece can be moved 
back just a little bit to allow 
the blade holder to drop 
down. 
 

Rim of blade holder is resting 
on the black part of the blade 
holder seat 
 

IMPORTANT:  Only install 
this way when cutting very 
thick materials! 
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o Now tighten the front screw carefully making sure you are NOT pushing down on the blade holder 
seat. Once tight, remove the spacer.  You should feel the tool gently scratching the top of the 
spacer. 

o This distance will provide the tool some “punch room” to give extra force and more consistent 
results.    

 

2.01.4 Adjust the Speed, Force, and Number of Passes Based on the Material and Shapes 

• Using correct cut settings is equally important as the type of blade, blade length, and blade height. Refer to 
Section 2.03 for details about each setting.  

 
 

2.01.5 Perform Test Cuts! 

• You have two options: 

(1) Perform the built-in test cut on the Skycut itself using the Test option on the Main Screen or from within 
the Speed/Force Screen. 

(2) Select any basic shape and size it to be around 0.3” – 0.5” (~ 8 mm – 13 mm): 

o Use the same instructions from Section 1.13.3 to add a basic shape for cutting.  

o When cutting intricate shapes, use a small letter or a shape will lots of sharp turns for testing. For a 
rhinestone project, use a small portion of your rhinestone pattern as a test. 

• There is a flow chart in Section 2.09 which will help you determine which settings to change when test 
cutting a material.  

 

2.01.6 Keep the Cutting Mat Clean and Sticky 

• Press your materials evenly to the mat.  Consider using a brayer both before AND after cutting. Repressing 
the material after cutting can greatly aid in weeding the cut shapes from the waste. 

• When necessary, tape thicker materials to the mat to keep them from slipping during the cut.  

• If you cut a range of materials, you might need more than one mat so that you can use stickier mats for 
certain materials. 

• Refer back to Section 1.08 for information on cleaning the cutting mat and adding more adhesive, 
 
 

2.01.7 Don’t Get Frustrated, Get Help! 

• Besides having your own Skycut dealer as your first line of contact, there are other resources where you 
can ask questions and get answers. Utilize the resources listed in Section 1.01. 

 
 

Pen tip just touches top 
of spacer 
 

Spacer is on top of material 
which is on top of mat 
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2.02 Choices Before Cutting 

• There are a number of factors under your control for cutting: 

 What shapes to send to the cutter: Section 2.02.1 

 Where the shapes will be cut from the material: Section 2.02.2 

 What tool(s) will be used for cutting (or drawing, scoring, engraving, etc.): Section 2.02.3 

 What settings will be used: Section 2.02.4 
 
 

2.02.1 Controlling Which Shapes Will Cut 

• For this tutorial, the following shapes were created and then imported into SignCut Pro: 

 

• In the upper right-side corner of the SignCut Pro screen, is the Color Toolbar with the following options:  

 

• Depending on your preference, you can display shapes in either wireframe of filled mods. Choosing one or 
the other does not affect the outcome of the cutting.  It is for display only:  

 

 

       

Switch between wireframe 
and filled views 

Select the black shapes 

Select the blue shapes  

Select the red shapes 

Select all colors 

Switch between optimized 
and whole area (refer to 
Section 2.02.2) 

Filled mode  
 

Wireframe mode  
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• There are several methods of selecting which color shapes to send to the cutter: 

 Option 1: If all shapes are showing, then all shapes will be sent to cut: 

    

 Option 2: Click on any color thumbnail and only those shapes will be displayed. Those will be sent to 
cut. In this example, only the red thumbnail was selected: 

    
 

 Option 3: Click on any color thumbnail and, while holding the Shift key, click on one or more thumbnails 
of another color. The shapes in those colors will be displayed and they will be sent to the cutter. In this 
case the red and the black thumbnails were selected:  

    

 Option 4: Hold the Shift key and click on any color thumbnail and it will be removed from the display.  In 
this case, the Shift key was held and the red thumbnail was clicked, leaving blue and black displayed: 
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 Option 5: Instead of selecting by color, you can also mark individual shapes to be cut, excluding others 
that are still displayed: 

o Click on the Tools for objects icon   on the left side Main Panel. In the Sub-toolbar at the 
bottom of the screen, the following icons appear: 

 

 

 

 
 
 

▪ Marking tool : with this icon selected, you can click on a shape to select it. If you need 
more than one shape selected, hold the Shift key while clicking on additional shapes. The 
border on a selected shape will become a thin black dashed line. If you have difficult discerning 
the dashed line, switch to wireframe mode: 

   

▪ Switch between all / none : Toggle between having all shapes selected or none selected 

▪ Switch between marked / not marked : Invert the selection (any selected shapes will 
become unselected and vice-versa) 

▪ Change color of selected objects : Opens a color palette window where a different color 
can be selected 

▪ Setup path(s) attributes :  Use this window to change various cut settings (refer to 
Section 2.02.3)   

o With the Marking tool icon highlighted, select the shape(s) that you want to cut. In this example, 
the red circle and the blue circle will be selected. Wireframe mode is also shown: 

Setup path(s) attributes 

Change color of 
selected objects 

Switch between 
marked / not marked 

Switch between 
all / none 

Marking tool 

Wireframe mode 

Dashed border is 
easy to see 

versus 

Dashed border is a 
bit difficult to see 

Filled mode 
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o Click on the Cut out icon  and, in the preview window, these two selected shapes are the only 
two present for cutting and have been arranged to optimize material usage:  

 

 

                         

2.02.2 Controlling Where Shapes Will Cut 

• The top icon on the Color toolbar is a setting which switches between Whole area and Optimized. Using the 

same shapes from Section 2.02.1, assume that only the blue shapes have been selected to cut:  

 Whole area : shapes will be cut from the material as if the other shapes were still present:   

         

 Optimized : shapes will be moved and cut in alignment with the origin set on the cutter:  
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• In what applications is one mode preferable over another? 

 Use Whole area mode when it matters where shapes are cut from the material:  

o Two tool applications, such as when scoring with a scoring tool, followed by cutting with the blade 
holder 

o When engraving on existing objects, such as trophy labels or charms 

o When cutting from a specific location, such as the center of a piece of material 

 Use Optimized mode when it doesn’t matter where shapes are cut. Since the shapes are moved to cut 
at the origin, it typically wastes less material. 

• You can also rotate a design before cutting by clicking on the Rotate image in 90 degree steps icon  
at the bottom of the screen when in normal mode. Note that the Tab key is a handy shortcut for this 
function. Each click will rotate once counter-clockwise, allowing you a choice of four orientations: 

                      

• Two other rotation options at the bottom of the screen: 

 Rotation for minimum vinyl consumption  : This function determines the best of the 4 possible 
rotations that will use the least amount of material. 

 Reset the Rotation : This function returns the shapes to the original rotation, however note that if 
you have elected to have files rotated upon being imported (under Settings>Settings>Default Folder), 
this setting will return it to how the shapes were positioned in the original file. 

 
     

2.02.3 Where to Enter Cut Settings  

• There are four locations where Cut Settings can be accessed in SignCut Pro (although not all offer the 
same settings): 

 Select the Cut Out icon  on the Main Panel, then the Tool settings tab (as was shown in Section 
1.13)  

The bounding box of the shapes is 
now aligned at the origin 
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 Select the Cut Out icon  on the Main Panel, then the Advanced settings tab  

 Right click on any of the color thumbnails on the Color Toolbar 

 Select the Tools for objects icon  on the Main Panel, select any or all of the shapes, then select 

the Setup path(s) attributes icon  on the Sub-toolbar  

• Cut Out  > Tool settings tab 

 The settings entered in this window will be used for all shapes assuming: 

o You check the box labeled Use software force and speed parameters (Otherwise, regardless of 
what force and speed settings are used in the other windows, the Force and Speed setting on 
Skycut’s control panel will be used. 

o You haven’t entered specific settings by color or by selected shapes (as will be covered in the 
subsequent options) 

 Thus, this is the best option to use when the same settings are used for all shapes in the project:  

 

• Cutout > Advanced settings tab 

 With this option, different cut settings can be assigned based on color. This works well in projects where 
some paths need to be cut as dashed lines (also called pouncing) or in multiple-tool projects, such as 
score and cut.  

 At the bottom of the Advanced settings window, a list of each color used in the project will appear with 
the following options: 

 

 

 

 

Save setting: refer to Section 2.04 
Check this box if you want force 
and speed sent from the software 
versus on the control panel 
 Choose Force 

and Speed: refer 
to Sections 2.03.1 
and 2.03.2 

Dashed line cutting options: 
refer to Section 2.03.6 
 

Change cut direction option: 

Blade offset settings: 
refer to Section 2.03.3 
 

Tool selection menu 
 

Multi-cut settings: refer 

to Section 2.03.5 
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 Cut in colour order: Marking this option will no longer cut shapes with respect to location in the project. 
Instead, all shapes of the top color in the menu will be cut before cutting shapes of the next color and so 
on down the list. 

 If using the Cut in colour order option, the order in which the colors are cut can be changed using the 
up and down arrows below the menu of colors. First, click on a color from the menu and then move its 
cut order as desired. 

 To the right of each color are the current Force, Speed, Passes, and Tool assigned to that color. Note 
there are additional settings that can be made. To make changes, click on a color and then click on the 
Edit attributes button below it. The follow window will open: 

 

• Color Toolbar 

 Use this option instead of the Advanced settings tab to assign cut settings to each color:   

Colors active in project 

Move a selected 
color up or down in 
the list 

Open Edit attributes 
window 

Mark this option to change 
cut order by color 

Current settings 
assigned to shapes 
of each color 

Mark this option if a tool 
change is needed before 
executing this scolor 

Enter Force and Speed 
 

Enter Pounce (dashed line) 
settings (refer to Section 
2.03.6)  
 

Rotary engraving 
settings (not applicable 
to Skycut use) 
 

Select a Preset, if set up 

Number of Passes 
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o First, left click on a color thumbnail on the Color Toolbar to select the shapes of that color and hide 
those of other colors. If another color will share the same cut settings, then hold the Shift key and 
left click on that color (or more, as appropriate). 

o Right click on any of the selected thumbnails and the same Set Attributes window will open where 
settings can be entered.  

o These new settings will then match those assigned by color in the Advanced settings tab. 

• Tools for objects > Setup path(s) attributes 

 Use this option if you want to select particular shapes and temporarily override the current cut settings 
assigned to those shapes based on their color.  

 Use the instruction in Option 5 of Section 2.02.1 to select the shapes you wish to cut. In this case the 
same two circles as presented in that section will be selected: 

 

 Click on the Setup path(s) attributes icon  on that Sub-toolbar . The same Set Attributes window opens 

and new settings can be entered.  

 Go to the Cut out window and, again as shown in Option 5 of Section 2.02.1, the shapes are moved to the origin 
and nested.  
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 After cutting, the settings for these shapes will return to those assigned to their respective colors.  

 Depending on the application, having the shapes automatically nest and cut at the origin may not be 
what you need.  Thus, one solution would be to change their color to something not already used in the 

project. After selecting the shape(s), choose the Change color of selected objects icon .  Then 
use the Color toolbar option to change the cut settings for that color. 

• Final note:  Remember that when using any of these cut setting windows, the option for Use software 
force and speed parameters must be checked on the Tool settings tab in the Cut out window.  

 
 

2.03 Cut Settings 
 

2.03.1 Force 

• Force (also called Pressure) ranges from 30 to 160 where the maximum of 160 represents ~2000g of 
cutting force. If it is set too low, the material cannot be cut. In fact, it is recommended that the minimum 
setting is always 30 or higher.  However, if it is set too high, you will get bad cutting (even incomplete cutting 
at times) and tearing of the material. Always perform small test cuts before cutting your actual project and 
make adjustments in order to get a clean test cut before proceeding with your larger cut. 

• Dull blades will need more force than new blades, thus anticipate increasing the force over the life of the 
blade. 

• When cutting materials that can use either blade, the 45o blade (red cap) will need a little more force than 
the 60o blade (blue cap), because of the extra contact with the material being cut and because the 60o blade 
is cut much thinner, making it a “sliver blade.” 

• As noted earlier, this setting can be made on the Skycut control panel instead. Press the Force/Speed icon 

 and then set the FORCE to the desired level. 
 
 

2.03.2 Cut Speed and Up Speed 

• Cut Speed (also called Down Speed) is how fast the blade travels while it is in the “down” or cutting 
position. Up Speed (also called Travel Speed) is how fast the blade travels while in the “up” position, such 
as when it is moving from the origin to the location of the first shape to cut or when moving from one cut 
shape to begin cutting another.  

• The Skycut has 13 speed settings ranging from “snail’s pace slow” to “insanely fast.”  

The two circles are 
nested by the origin 
for cutting 

The two circles 
are selected  
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 The settings from 1 through 4 are the slow speeds and should be used when cutting dense difficult 
materials, such as chipboard, craft plastic, styrene, and balsa. 

 The settings from 5 through 8 are medium speeds and should be used for easy-to-cut materials, such 
as cardstock, vinyl, iron-on transfer, and rhinestone template material. 

 The settings from 9 through 12 are the fast speeds and are useful for engraving, embossing, and 
drawing.  You may, however, find that some materials will cut well at the faster speeds. 

• Cut Speed is usually more important to control since the blade may need more contact time with a 
particular material. Up Speed can usually be left quite high although, for print and cut accuracy, it may need 
to be lowered if there are many shapes to be cut from a printout.  

• Currently, SignCut Pro does not have the option to send Up Speed from the software. Thus, if you need a 
separate Cut Speed and Up Speed, please use the control panel for this setting. 

• On the Skycut control panel, the default setting is to have the Up Speed and Cut Speed the same and 

referred to as SPEED. This can be adjusted by pressing the Force/Speed icon  and then setting the 
SPEED to the desired level.  In order to enter a separate Up Speed on the control panel, refer to Section 
1.14.1. 

 
 

2.03.3 Blade Offset 

• Blade Offset is the horizontal distance from the center of the blade shaft to the tip of the blade.  A pen or 
engraving tool has an offset of 0 because the tip is centered with the center of the pen/engraving tool shaft. 
But a blade is different: 

 
  

 
  
 
 
 
 

• If you set the Blade Offset to 0 when cutting with a blade, corners will be rounded. On the other hand, if it is 
set too high, bubbles will be cut on sharp corners: 

  
 
 

 
 
  
 
 
 

• Below are the approximate Blade Offset settings to use for each of the three types of Skycut blades: 

 Red capped blade: 0.3 mm 

 Blue capped blade: 0.4 mm 

 Blue capped reflective blade: 0.6 mm 

 Yellow capped blade: 0.75 mm 

• Any time you order new blades, check for the recommended Blade Offset on the packaging.  However, it’s 
not unusual for blades to be slightly off-spec. 
 
 

Offset is too low: 
corners are rounded 

Offset is too high: bubbles 
appear at the corners 

Imagine a line 
passing through 
the center of the 
test pen or 
blade 

The Offset is the distance 
between the center of the 
blade holder and the tip of the 
blade. 

There is no 
Offset on a 
pen. 
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2.03.4 Overcut 

• Overcut is related to Blade Offset in that it isn’t needed when using a pen, embosser, engraver, and so 
forth, because the tips of those tools are aligned with the center of the tools themselves. However, leaving 
Overcut at 0 when using the blade holder will result in large shapes not quite closing: 

  
 
 
 
                             
                       

• In some cutting programs, Overcut is not a separate setting but rather automatically calculated and applied 
based on the Blade Offset entered. However, in SignCut Pro2, you can enter an actual Overcut setting and 
should do so any time a blade is used.   

• In general, the blade type doesn’t greatly affect the Overcut required. Try using 1.00 mm. In the event you 
cut a large closed shape, like an 8” circle, you may find that you’ll need to increase Overcut to 2.00 mm.  
 
 

2.03.5 Passes 

• The Passes setting causes each individual path to be cut the set number of passes before the blade moves 
to the next path to cut. This is better than just repeating the entire cut as each repeated pass is cut with the 
blade held down throughout the repeated passes, resulting in cleaner cutting. 

• Both the Cut Out >Tool settings tab and the Set Attributes window have a Passes option which can be 
marked and then the number of Passes set: 

                  

• Passes is recommended in the following situations: 

 Cutting thicker denser materials, such as chipboard, where multiple passes allow the blade to 
progressively “carve” through the material 

 Cutting certain fibrous materials, such as fabric, where a second pass will ensure that all of the fibers 
have been cleanly cut 

 Cutting intricate or detailed shapes (such as script titles) from certain materials, such as heavy or 
textured cardstock, where a single pass may leave certain spots not cleanly cut 

 Cutting rhinestone template material where a second pass results in much cleaner weeding of the cut 
circles 

Overcut is too low: 
paths do not close 

Set Passes  

Set Passes  
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• Passes can also be set on the Skycut control panel when, for example, a cut is being made using a USB 
flash drive.  However, unlike using Passes from SignCut Pro, the blade does not stay down to repeat the 
cut. The Passes function behaves like a repeat cut.  

 If you are only using the left side or only the right side, press the USB button on the Main Screen and 
you will see a Passes button in the window which opens: 

 

 Press the Passes button to open the following screen where you can turn on the Passes function and 
enter the desired number of repeats: 

 

• If you are planning to use both heads, make sure Use Double Head is activated on the control panel’s Main 
Screen. If you do not see this option (as shown in the following screenshot), click on Set>Advanced 
settings>System mode and select double. Then, back on the Main Screen, the following options should 
now appear: 

 

 

 

 

 

 

Press Passes 

Use + and – buttons to enter 
number of Passes 

Mark this option to activate Passes 
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 Press the USB button on the Main Screen and you will see a Passes button in the window which 
opens: 

 

 Press the Passes button to open the following screen: 

 

• Recut mode has two options: 

 If the upper option is marked, then the screen shows a setting called Recut times which you set based 
on the number of passes you want both sides to perform (when doing dual head applications). Note that 
it will execute both sides’ shapes before doing additional passes.  

Press Passes 

Use + and – buttons to enter 
number of Passes 

With the upper option selected, 
the screen will display Recut 
times: 

Mark this option to activate Passes 

Choose the recut mode based on 
descriptions below  

Select Use Double Head 
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 If the lower option is marked, the screen changes and you can enter different passes for the two heads 
to perform. Note that it will execute the passes on one side before executing the passes on the other 
side: 

 

• IMPORTANT: Currently the Open recut option will default to off whenever the Skycut is first powered on. 
Thus, make a mental note (or, even better, put a Post-It note on your cutter) to turn this option on when 
using multiple passes in dual head operations. 

 

2.03.6 Pounce (Dashed-line Cutting) 

• If you have an application that needs dashed cut lines, Pounce settings can be made in both the Cut Out > 
Tool settings tab and in the Set Attributes window: 

 

   
 

• Enter the values for the following settings: 

 Pounce down length: this is the length of the dashed cut  

 Pounce up length: this is the spacing between the dashed cut lines 

 If you are unsure about what to use, try 3 mm (0.12”) for Pounce down length and 6 mm (0.24”) for 
Pounce up length as a test. In general, you want the spacing to be larger than the dash, especially if 
the dashed cut will be folded and unfolded repeatedly. 

 
 

 
 

Use + and – buttons to enter 
number of Passes 

With the lower option selected, 
the screen will display separate 
Fold and Cut pass options 

Mark this option to activate Passes 
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2.04 Presets 

• Presets allow you to save your settings for a particular material or application, such as cutting posterboard 
or scoring cardstock.  A preset can be entered in SignCut Pro or saved on the Skycut control panel. 

 

2.04.1 Saving a Preset in SignCut Pro 

• Go to the Cut out >Tool Settings window and enter the settings for the material or application:  

 

• At the top, enter the Name you wish to save the settings under. Then click on the Save icon: 

 
 

• This preset will now be available in the dropdown menu, both in this same window or from the Set 
Attributes window: 

 
 
 

2.04.2 Saving a Preset for a Material 

• IMPORTANT: As was noted in Section 2.02.4, Up Speed (aka Travel Speed) is not functional in SignCut 
Pro2 and both speed settings do not apply with Tool 1 (right side) applications. Thus, unless using a preset 
with Tool 0 (left side) cutting, it is recommended that presets be made on the control panel.  

• Before proceeding, note the following: 

Enter all settings for the 
material or application 

Click here to save 

Type in a Name: 
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 Even if you are not using the right side for a particular material, make sure the control panel is set to 
Double under Set>Advanced Settings. Otherwise any presets entered will be automatically assigned 
to the right side.  

 Because settings for any given material or application would need to be entered twice to make those 
settings available for both right and left sides, consider which side you might always choose to use. For 
example, if you always use the left side for cutting and the right side for scoring, then only enter those 
settings for those sides.  

 There’s a maximum of 10 presets allowed, thus consider which materials or applications are most 
important to you. 

• To create a preset: 

 Verify that Use Double Head is selected on the main control panel screen: 

 

 

 Press the Force/Speed icon  to open the Force/Speed screen: 
 

 
 
 

 Make the necessary changes to the SPEED and FORCE settings. Select Save and the following screen 
opens: 

Adjust settings by sliding bar 
or using + and - buttons 

Click on Save 

Select which side will 
be used 

Mark Use Double Head 
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 Press one of the unused preset boxes, e.g. name5, and it will turn blue indicating it is highlighted. Select 
Rename.  

 A window opens where you can enter the name for the new Preset. The characters are entered in the 
same manner as the Password entry window in Section 1.12.2.  Note that there is a 15 character limit. 
Click on OK when done: 

 

 

 You will now see the name of your new preset and you can press Save to add it to the saved presets 
with the FORCE and SPEED you set.  You will be returned to the Force/Speed screen. 

Delete last 
character 

 

New preset name 
will display here 

 

Click OK when done 

 

Toggle to switch between 
uppercase and 
lowercase letters 

 

Switch to punctuation 

 

Switch to 
numbers 

 

Select an 
unused box Select 

Rename 
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 To verify the preset or to select a different preset, press Preset. The Preset window opens where you 
can see all of the Presets, along with the settings for those presets.  In that window you can also select 
a different preset. Then you can select Rename to edit its name or select Load to select that preset’s 
Force and Speed into the Force/Speed screen. Note that if you need additional Passes when cutting a 
material, they will need to be set using the instructions from Section 2.03.5. 

   

 

 

 

 

 

2.05 Setting the Origin before Cutting 

• Before you cut, you should check to see where the blade tip is located in relation to the material so that the 
shapes will cut in the appropriate location. 

• IMPORTANT! The Skycut D24 has a maximum cutting width of 24 inches. If you move the head too far to 
the left to begin the cut and your project is wide, you may exceed the left side limit and cutting will stop at 
that point with no option but to abort.  

• To set the origin, press the arrow buttons on the main screen of the control panel. Remember that the 
middle button can be toggled between regular speed and a slow speed for more control: 

Select 
Preset 

Select Rename to 
edit the name 

Select Load to change 
Speed and Force to 
these settings  

Press Save 

New Preset 
name 
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• In general, you set the origin near the lower right corner of the material, as you did during your initial test 
drawing in Section 1.13.  

• If you ever choose to have Use R (Head) (P1) selected on the control panel, the origin will be base on the 
right-side tool, verus the normal left side: 

 
 
 

 

2.05.1 Setting an Origin Using the Camera 

• In the event you need to set an extremely precise origin, the Skycut’s built-in camera can be used: 

(1) Go to Section 3.03 and perform the camera calibration.  

(2) Choose where you want the origin to be set. You’ll need an “origin target” to use when the camera takes 
a photo. It can be a dot on your material, the corner of your material, the intersection of grid lines on the 
mat, etc. If you do choose the latter, make sure there’s a way to clearly distinguish which intersection 
you want to use. 

(3) On the Skycut’s Main Screen, use the arrows to move the center of the blade holder roughly over the 
origin target. In this example, a dot will be used. 

Press here to 
toggle origin 
setting speed 

Press here to switch to right side only. 
 
The origin will now be based on the 
tool mounted on the right side of the 

Skycut D 
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(4) Select Set and Camera. In the Camera Screen, press OK. A photo will be taken and displayed. If 
needed, press X3 so that you are zoomed out and able to see the origin target (dot) in the photo: 

 

 

(5) Press the center of the origin target in the photo so that the red + will be moved approximately over it: 

 

 

(6) Press OK. In the new photo, the blue dashed + should be close to the origin target. Press X3 to zoom 
in: 

   

 

(7) Use the arrow buttons to move the red + as close as possible to the center of the origin target: 

Origin Target (dot) 

Red + 

Blue dashed + 
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(8) Press OK. At this point the blue dashed + should be centered with the origin target: 

 

(9) Press the Home icon to return to the Main Screen. The head should move so that the blade holder is 
now located over the origin target and you can proceed with the cutting process. 

 
 
 

2.06 Other Cut Setting Functions  

• There are other functions and features available in SignCut Pro and on Skycut’s control panel that will be 
useful depending on your applications. Some have already been covered. Some will be covered in this 
section. Others will be covered in later parts of this manual.  

2.06.1 Advance Mode  

• The Advance After Plot option in SignCut Pro2 Pro is actually controlled on the Skycut itself. The function 
can be opened by going to Set>Advance Mode on the control panel. 



 67 

 

 

 to start will cause the blade holder to return to the origin after cutting. 

 to end will cause the blade holder to advance forward to the end of the cut project. 

 to left will cause the blade holder to move to the left of the cut project. 

 The settings below the option are activated when choosing either to end or to left. You can enter a 
specific distance for the blade holder to advance. This is useful when cutting repeats of the same 
project because it allows for the origin to be set automatically for the next repeated cut. 

 
 

2.06.2 Mirror 

• Checking the Mirror option  on the sub-toolbar will apply a horizontal mirror to the shape (s) before 
cutting. This is useful in applications such as: 

 Cutting HTV in which the material is placed faced down so that the heat protection layer is not 
penetrated by the blade 

 Cutting vinyl to be applied to the inside of a car or home window but primarily viewed from outside of the 
window 

 When cutting certain non-homogenous paper materials in which cutting upside down yields cleaner 
results 

  
  

 
 
 
 

2.06.3 Weeding Line Tools 

• For those cutting vinyl and HTV, the Weeding line tools   in SignCut Pro are very useful. Upon 
selecting the icon (or shortcut T), the sub-toolbar displays the following options: 

 

Use “-“ and “+” buttons to 
set an advance amount 

Select from these 
three options 

Before applying Mirror After applying Mirror Click here 
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• Before covering each option, note the following: 

 For most of the functions, left clicking the mouse will add a weed line. Holding Shift and/or Ctrl will 
provide additional options. 

 Weed lines can be dragged, as needed. 

 To delete a weed line, hold the Ctrl key and right click on the line. 

 For projects that will be cut by color, each color can be individually selected on the Color Toolbar and 
the weed lines added for only that color. 

• Normal Horizontal Weed Line - Left click once where you want a horizontal weed line added: 

 

 Hold the Shift key while clicking and instead of creating a horizonal line, a vertical weed line will be 
made. While there is a second option on the sub-toolbar for adding vertical weed lines, it can be more 
convenient to add them while in Horizontal weed line mode if you’re needing both types of weed lines: 

 

 Hold the Ctrl key and left click to add short weed lines inside any spaces you choose. For example, 
short lines were added in these three spots: 

 

Normal horizontal 
weed line 

 

Delete all weed lines 

 

Short 
weed line 

 

Automatic 
weed lines  

 

Normal vertical 
weed line 

 

Inverted 
weed line 

 

Short weed 
rectangle 

 

Detailed 
weed line 

 

Click to add a 
horizontal weed line 

Hold the Shift key and left click 
to add a vertical weed line 
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 Holding both the Shift key and the Ctrl key while clicking allows you to add short vertical weed lines, as 
needed.  

• Normal Vertical Weed Line  – Left click once where you want a vertical weed line added: 

 

 

 Hold the Shift key while clicking and instead of creating a vertical line, a horizontal weed line will be 
made. Again, this can be more convenient to add them while in Vertical weed line mode if you’re 
needing both types of weed lines: 

 Hold the Ctrl key and left click to add short vertical weed lines inside any space you choose. For 
example, short lines were added in these three spots: 

 

 

 Holding both the Shift key and the Ctrl key while clicking allows you to add short horizontal weed lines, 
as needed.  

• Short Weed Line - If you need to add a lot of short weed lines or, perhaps, only short weed lines, then 
this option will allow you to left click to add short lines without needing to hold the Ctrl key.  Hold the Shift 
key to add short vertical weed lines: 

 

Hold the Ctrl key and left click to 
add short horizontal weed lines 

Click to add a vertical weed line 

Hold the Ctrl key and left click to 
add short vertical weed lines 
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• Inverted Weed Line - In some cases, such as stencil applications, the part being weeded is the 
opposite.  Thus, what is normally the waste part of the material is the part being kept. Thus, in this example, 
it would be the letters themselves being weeded away, so having weed lines inside the letters would be 
desirable. Use the Inverted Weed Line tool to place weed lines inside the letters: 

 

• Detailed Weed Line - This option adds the weed line through any internal shapes as well as the 
normal waste area outside. Note the difference between the Normal Horizontal Weed and Normal Vertical 
Weed versus using the Detailed Weed Line option: 

       

• Short Weed Rectangle - Drag the mouse to create a rectangle which is added as a weed, along with 
horizontal and vertical extended weed lines: 

Hold the Shift key and left click 
to add short vertical weed lines 

Left click to add short 
horizontal weed lines 

Weed lines are placed 
inside the letters 

Normal horizontal weed option Detailed weed line option – weed lines pass 
through interior shapes, as well 

versus 
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• Automatic Weed Lines  - Automatically adds weed lines to the design. Left click to add horizontal 
lines and/or Shift + left click to add vertical lines: 

         

 Note that this option is also available on the sub-toolbar when in Collection of commonly used tools 
mode. 

• Delete All Weed Lines  - Clicking this icon will delete all weed lines. 
 
 

2.06.4 Tiling Options 
 
When cutting projects that are larger than the maximum cutting width of the cutter or the available material, the 
project will require tiling. This involves dividing up the design into rectangles that will later be pieced together 
after cutting. SignCut Pro offers two ways to accomplish this: automatically by entering the dimensions of the 
desired tile size or manually by clicking to add tile lines to your project. 
 
Automatically Creating Tiles 

• The Tiles Panel above the Work Area contains the tools needed to automatically tile a project into 
individual tiles based on dimensions entered. In this example, a large tree design will be tiled for application 
using 12” wide wall vinyl: 

 

 

 

 

 

 

 

 

 

Left click here Shift + left click here 

Drag mouse from here to here Rectangle is created with extending lines 
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• In some cases, the limiting factor which leads to the need for tiling is the maximum cutting width of the 
cutter. In other cases, as presented here, the limiting factor is the width of the material available.  

• Click on the Tiles button and the following window opens:  

 

 Tile size: Enter the maximum Length and Width of each tile.  Assuming the vinyl is on a roll, the 
Length can be left at a maximum size. The Width, however, will be changed to 11” because the wall 
vinyl happens to be 12” in width.  

 Automatic tile overlap: mounting vinyl can be easier if a small amount of overlap is allowed. This 
ensures there will be no unsightly gaps in the final project after application.  

 Mounting frame: mark this option to add a rectangle around the tiles. This can aid in alignment and/or 
weeding, as needed.   

• After entering the Tile Size Width as 11 inches, click on Ok to close the window. Then click on Create tiles 
and the preview will update with the 11” tiles generated: 

 

 

 

 

 

Tiles Panel  

The Width will be 
changed to 11”  
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 Note that the Width indicated as 10.9843” instead of 11” is a programming round-off error and is 
neglible in size. 

• At this point, if you were to send the project to cut, all four tiles will be cut, one after another, as shown in the 
Cut Out window: 

 

 If the Mounting frame option has been marked in the Tile settings window, then each tile would have 
been surrounded by a rectangle and the preview would appear like this: 

 

• If you prefer to not cut all of the tiles, click on the Activate / deactive tiles icon located on the sub-
toolbar and click inside any tiles to deactivate: 

 

 

Click on Create tiles to 
generate tiles based on 
current size settings 

Tile 4 

Tile 2 

Tile 1 

Tile 3 

Tile 1 Tile 2 Tile 3 Tile 4 

Tile 1 Tile 2 Tile 3 Tile 4 
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• The Cutout window has additional tile settings whereby you can have copies of tiles made and specify the 
distance between each copy. For example: 

 

 
 
 

 Note the additional tile settings also available in this window: 

o Use weeding frame and Weeding frame distance: Same as setting in the Tile window but 
conveniently located here in case it was forgotten. 

o Stack copies/ tiles: when checked, tiles will be arranged across the width of the cutter, if space 
allows.  

 
Manually Creating Tiles 

• The Tiling tools   in SignCut Pro allow you to break up the design by clicking in the Work Area to add 
horizontal and/or vertical cut lines. Upon selecting the icon (or shortcut W), the sub-toolbar displays the 
following options: 

  

 
 
 
 

Pointer tool 

 

Draw free tiles 

Activate all 
tiles 

 

Vertical 
tile line 

 

Activate/ 
Deactivate 

 

Manual tile 
overlap 

 

Horizontal 
tile line 

 

Short vertical 
tile line 

 

Deactivate 
all tiles 

 

These three tiles 
are deactivated 

Activate/deactivate 
tiles selected 

In the Cut out window, only the 
top tile appears 

Copies set to 3 with a spacing of 0.25” 

The top tile will be cut three times 
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• The following example will be used to illustrate the use of the Tiling tools: 

 
 

 Note the purple dashed line indicates that the design exceeds the maximum cutting width of the C16 
Skycut, which will be used. This purple line is automatically the first tile line.  

• Before covering each option, note the following: 

 For most of the functions, left clicking the mouse will add a tile line. Holding Shift and/or Ctrl will provide 
additional options. 

 Tiles lines can be dragged, as needed. In this example, the first purple tile line is dragged so that it is 
between the two lines of text: 

 

 To delete a tile line, hold the Ctrl key and right click on the line.  Note that if you delete a tile line that’s 
required in order for the project to be cut based on a cutter’s maximum limits, the tiles will automatically 
become deactivated: 

 
 

• Add vertical tile line - Left click once where you want a vertical tile line. Normally, when cutting from a 
roll of material, vertical tile lines won’t be needed.  But if the material on the roll isn’t long enough for the 
entire project or if you prefer to cut using a cutting mat, then this option can be used: 

 
 
 
 
 
 
 
 

First tile line is 
automatically 
added  

Tiles is deactivated  

After deleting the 
horizontal tile line, the 
tile is larger than the 
maximum cutting width  
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 Hold the Shift key while clicking and instead of creating a vertical line, another horizontal tile line will be 
added. While there is a second option on the sub-toolbar for adding horizontal tile lines, it can be more 
convenient to add them while in Vertical tile line mode if you’re needing both types. 

 Hold the Ctrl key while clicking to add a short vertical tile line:  

 

 

 

 
 
 

• Add horizontal tile line - Left click once where you want a horizontal line. In this example, another 
line of text has been added to the design in SignCut Draw. In SignCut Pro, another horizontal tile line is 
added:  

 

 
 
 
 

 Hold the Shift key and left click to add a vertical tile line, while in this mode.  
 

• Add short vertical tile line  - Left click to add short vertical tile lines between horizontal tile lines: 
 

Click to add a vertical tile line 

Add vertical tile 
line selected 

Press Ctrl and click to add a 
short vertical tile line 

Add vertical tile 
line selected 

Left click to add a 
horizontal tile line 

Add horizontal 
tile line selected 
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• Manual tile overlap - Some users prefer to have a small amount of overlap in the tiles so as to avoid any 
possible gap when aligning the cut pieces. To apply, drag an existing horizontal tile line upwards and/or 
drag a vertical tile line to the right: 

 

 
 
 
 

• Activate / deactivate tiles - as covered earlier, click inside any tile to toggle whether or not it is sent 
to the cutter for cutting. For example, the lower two lines are deactivated: 

 

  
 
 

Left click to add a short 
vertical tile line 

Add short vertical 
tile line selected 

Left click to add a short 
vertical tile line 

Drag vertical tile 
lines to the right 

Manual tile 
overlap selected 

Drag horizontal 
tile lines up 

These tiles are 
deactivated 

Activate/deactivate 
tiles selected 

In the Cut out window, only the 
upper line of text appears 
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 The same tile settings in the Cut out window can be used to make additional copies with a specified 
spacing, add a weeding frame (in case it wasn’t originally marked in the Tile window), etc.  

• Deactivate all tiles  - click this icon to deactivate all of the tiles. The prior icon, Activate / deactivate 
tiles icon will now be highlighted and you can click on any tile to reactivate it, as desired. 

• Activate all tiles - click this icon to activate all of the tiles. As with the Deactivate all tiles, the mode 
will switch to Activate / deactivate tiles so that you can the individually deactivate any, as needed. 

• Draw free tiles - click this icon and then drag your mouse to create rectangular tiles where needed. For 
example, if a few parts of a design need to be recut, then rectangles can be draw around just those parts to 
create tiles to be sent to the cutter: 

     
 
 
 
 
 
 

2.07 Important Checklist Before You Cut! 

• Do you have your material on the mat and the mat inserted into the Skycut?  (Note: materials with a backing 
sheet, such as vinyl and iron-on transfer do not require a mat for cutting) 

• Have you selected pinch wheels positions that are roughly the same distance from the outside edges of the 
cutting mat (or material, if not using the mat)? 

• Are the pinch wheels in use centered over grit shafts (located below the white rectangle labels)? 

• Do you have the pinch wheel lever raised (so that the pinch wheels are down)? 

• Have you set the blade length/exposure based on the thickness of the material you are cutting? 

• Do you have the blade holder firmly mounted in the blade holder seat and the blade tip at the correct height 
above the material? 

• Have you set the Origin (location of the blade tip) at the bottom right corner of your material (or wherever 
you need the origin to be)? 

• Have you selected the correct mode on the control panel (Left versus Right versus Double Head)? 

• Have you set the Force?    And the Speed?  Do you need to do a test cut? 

• Do you need to turn on Passes for this material? 

• Have you selected the correct Blade Offset for the blade you are using? 

• Do you see the correct shapes in the preview window? 

• Do you need to select Rotate, Mirror or Absolute (Position) options? Do you know, with confidence, where 
your shapes are going to cut? 

• Do you need to apply any weeding options? 

Rectangles drawn here Draw free tiles 
selected 

In the Cut out window,only 
those two tiles are sent to cut 
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2.08 Scale Calibration 

• If you were to cut out any particular shape, for example, a 10” x 10” square, you might find that it actually 
measures 9-15/16” x 10-1/32”. It will be very close to 10” x 10” but perhaps just slightly smaller or larger in 
either or both dimensions. Now this might be perfectly acceptable for the type of cutting you do. Therefore, it 
may not even be necessary to do this particular calibration.  However, if you do want to make sure your 
shapes are cut precisely to scale, the following procedure will allow you to calibrate your Skycut. 

• Before beginning the calibration, it’s a good idea to make sure the Scale values which can also be stored on 
the Skycut’s control panel are set at a default of 1. Go to Set>Advanced Settings> Scale. The following 
window opens: 

 

 

• In SignCut Draw click on the Shape tool on the Tools panel and then select the rectangle shape: 

 

 
 

• Left click once in the Sign Area, press and hold the Ctrl key and move the cursor down and to the right. 
Click again to create a square. Later the dimensions will be set.  

• The calibration process can be conducted in inches, cm, or mm.  Both mm and inches will be presented 
here. In general, it is recommended that mm be used, however, if you do not have a metric ruler, then you 
can use inches instead.  

• Pick one of the two following sections and follow the instructions. Once you have calculated your new X 
Scale and Y Scale, return to the screen above and enter the values using the + and – buttons. 

 

2.08.1 Skycut Resolution Using Millimeters for Measurement 

• In SignCut Draw, go to Settings>Settings and select millimeter (mm):  

1. Select the Shape tool 

2. Select the Rectangle 

Verify X Scale and Y Scale 
are both set to 1.0000 

Use the + and – buttons to adjust 
the numbers, if needed  
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• With the square still selected, change the width and height to the largest size that will fit on the paper you 
have available. It is recommended that the square be at least 250 mm x 250 mm:  

 

• Click on the Move image to Signcut icon to open the square in SignCut Pro. Use your test pen to draw the 
square.  Leave the paper on the cutting mat so as not to confuse which sides drew left to right and which 
sides drew up and down. 

• Using a mm ruler, carefully measure the Width (the left-to-right length that drew) and the Height (the top-to-
bottom length that drew:   

 

• Write those measurements onto your sheet: 

 

 

Width, X 
 

Height, Y 
 

Feed the mat this direction 
into the Skycut 

Select millimeter (mm) 
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• Verify that the units are set to Millimeters on the Cutter Panel.  If not, click on the button until Millimeters 
is displayed: 

 

 

• To open the Calibrate cutter size window, click on the Cutter button on the Cutter Panel. Select the 
Advanced settngs tab and, in that same window, click on the Calibrate cutter size button (lower right 
corner): 

 

 

 

      
  

• The following window opens where you will enter the size of the square you sent to cut, along with the 
actual size the square drew: 

 

 

• Draw the square again and measure to verify the square is now 250 mm x 250 mm.  

• Make adjustments as needed. For example, with the Width example above: 

 If the square is now drawing larger than 250 mm, then decrease the Width you entered as your 
measured value. Try entering 249.3 instead of 249.5. 

 If the square is still drawing smaller than 250 mm, then increase the Width you entered. Try entering 
249.7 instead of 249.5.  

• Once you have your calibration set, please record these values in your “little black book” in case your 
computer crashes and you lose your calibration.  

 

 

Click here to change 
untis to Millimeters  

Click on Cutter button  Click on Advanced 
settings tab  Click on Calibrate cutter 

size button  

Enter design’s Width  Enter design’s Length  

Enter Width as drawn  Enter Length as drawn  
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2.08.2 Skycut Resolution Using Inches for Measurement 

• In SignCut Draw, go to Settings>Settings and select inch: 

 

• With the square still selected, change the width and height to the largest size that will fit on the paper you 
have available. It is recommended that the square be at least 10 in x 10 in:  

 

• Click on the Move image to Signcut icon to open the square in SignCut Pro. Use your test pen to draw the 
square.  Leave the paper on the cutting mat so as not to confuse which sides drew left to right and which 
sides drew up and down. 

• Using a ruler, carefully measure the Width (the left-to-right length that drew) and the Height (the top-to-
bottom length that drew:   

 

• Write those measurements onto your sheet: 

 

 

Width, X 
 

Height, Y 
 

Feed the mat this direction 
into the Skycut 

Select inch (in) 
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• Use a calculator to convert the fractions to decimals.  In the example here, the Width would be 9.94 amd 
the Length would be 10.03. 

• Verify that the units are set to Inches on the Cutter Panel.  If not, click on the button until Inches is 
displayed: 

 

• To open the Calibrate cutter size window, click on the Cutter button on the Cutter Panel. Select the 
Advanced settngs tab and, in that same window, click on the Calibrate cutter size button (lower right 
corner): 

 

 

 

      
  

• The following window opens where you will enter the size of the square you sent to cut, along with the 
actual size the square drew: 

 

• Click on Ok. Draw the square again and measure to verify the square is now 10 in x 10 in.  

• Make adjustments as needed. For example, with the Width example above: 

 If the square is now drawing larger than 10 in, then decrease the Width you entered as your measured 
value. Try entering 9.92 instead of 9.94. 

 If the square is still drawing smaller than 10 in, then increase the Width you entered. Try entering 9.96 
instead of 9.94.  

• Once you have your calibration set, please record these values in your “little black book” in case your 
computer crashes and you lose your calibration.  
 

 

2.08.3 Scale Calibration Storage on the Control Panel 

 

Click here to change 

untis to Inches  

Click on Cutter button  Click on Advanced 

settings tab  Click on Calibrate cutter 

size button  

Enter design Width  Enter design Length  

Enter Width as drawn  Enter Length as drawn  
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• The Scale Calibration results can be stored on the Skycut’s control panel instead of within SignCut Pro. To 
do this, you’ll need to calculate the actual scaling value based on the results you ended up entering in 
SignCut Pro.  

Millimeters: 

• On your Skycut control panel, go to Set>Advanced Settings> Scale. The following window opens where 
you can verify that the current X Scale and Y Scale values are both set to 1.0000: 

 

• Use a calculator to calculate the X Scale and Y Scale based on the measurements you obtained: 

New X Scale = Width of the square in design divided by the measured width 

         = 250 / 249.5 

             = 1.0020 

New Y Scale = Height of the square in design divided by the measured height  

           = 250 / 251.5 

                = 0.9940 

• Return to the Scale screen (Set>Advanced Settings>Scale) and use the + and – buttons to enter these 
calibrations: 

 

 

Inches: 

• On your Skycut control panel, go to Set>Advanced Settings> Scale. The following window opens where 
you can verify that the current X Scale and Y Scale values are both set to 1.0000: 

Verify X Scale and Y Scale 
are both set to 1.0000 

Use the + and – buttons to adjust 
the numbers, if needed  
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• Use a calculator to convert the fractions to decimals based on the measurements you obtained: 

New X Scale = Width of the square in design divided by the measured width 

         = 10 / 9 15/16 

   = 10 / 9.9375 

             = 1.0063 

New Y Scale = Height of the square in design divided by the measured height  

           = 10 / 10 1/32 

                = 10 / 10.03125 

          = 0.9969 

• Return to the Scale screen (Set>Advanced Settings>Scale) and use the + and – buttons to enter the 
calibrations: 

 

• Draw the square again and measure to verify the square is now 10 in x 10 in.  

• Once you have your calibration set, please record these values in your “little black book” in case you ever 
need to reset your Skycut to default settings or install a firmware update. 

 

 

 

Verify X Scale and Y Scale 
are both set to 1.0000 

Use the + and – buttons to adjust 
the numbers, if needed  
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2.09 Test Cutting Flow Chart for the Skycut 

 

 
  

© 2018-2020 Sandy McCauley, All Rights Reserved 

 

Scratched the surface; 

did not cut through the 

material.  

Increase force by 10 and 

increase blade exposure by 

~1/4 turn.  

Return to 1.  

There are deep cut 

lines in the mat   

There are no cut lines 

or faint lines. 

If you have an intricate project, you may w ish to repeat using a partia l 

section of the project. Otherwise you are done!  Record your settings!  

Retract the blade a tiny bit.  

Return to 1. 

Cut was clean!  Perform the 

test cut.  

Check cutting 

mat*** for cut 

lines. 

1. 

Partial cut (cut through in some spots 

but not in others)  

Increase force by 10. If you’ve already repeated this 

step several t imes, try sett ing Passes = 2 (or higher 

on dense materials). If doing test cut at control panel, 

change Advance Mode: to Start so that a second 

test cut w ill be in the same locat ion.  

Return to 1.  

Cut was most ly clean but had some 

tearing and/or crumpling  

There are deep cut 

lines in the mat.  

There are no cut lines in 

the mat or faint lines.  

Retract the blade 

~1/8 -1/4 turn.  

Return to 1. 

Try one or more of the follow ing:  

• Decrease the force.  

• Make sure the mat is clean and sticky.  

• Try a different blade in case current 

one is chipped.  

• Dry the material.  

Return to 1. 

Check cutting 

mat*** for cut 

lines.  

A 

B C 

D 

*** or backing sheet, such as with vinyl  

             If a stuttering 

sound occurs during a cut and/

or the mat begins skewing, slow 

down the speed, lower the pres-

sure, and increase the number 

of passes. This will allow the 

blade to work its way through 

the material versus being 

forced.    

• Select a small test shape. You can use the built-in test on the Skycut.  However, a shape w ith an internal path, such as a ring, works better 

as it a llows you to more easily check to see if the blade is cutting into the backing sheet or cutting mat.  

• Start with conservative Force and Speed.  

• Insert the blade holder as instructed in Sect ion 2.01.3 .  

• On the control panel: Set>Advance Mode, choose to End or to Left and enter a small distance, such as 0.5” or 10 mm to space each test.  

• Set origin in the lower right corner of the material.  
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2.10 Settings Form for Cutting Materials 
 
 

Material 
Material Brand or 
Source 

Blade Force Speed  
Blade 
Offset 

# 
Passes 

Other Comments 

               

               

               

               

               

               

               

               

               

               

               

               

               

               

               

        

        

        

 

© 2009- 2020 Sandy McCauley, All Rights Reserved 
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2.11 Suggested Settings for Various Materials 
 
 
 
IMPORTANT: These settings should be used for the initial test cut only. Adjustments may be necessary based 
on the condition of the blade, variations in the material, humidity, condition of the cutting mat, blade tip height, 
etc. Refer to Section 2.09 for a guide to adjusting settings for optimizing the test cut. 
 

Material Type Material Brand/Source Blade Passes Force Speed Other Comments

Cardstock: light
Light: 65 lb (~176 gsm) 

Recollections
R 1 35 8

Cardstock: medium Medium: Textured Bazzill R 1 40 8 Blade tip ht = 40 Post It notes

Cardstock: heavy
Accent Opaque 270 gsm (100 

lb cover)
R 1 75 5

Chipboard: cereal 

box
 0.018" (0.4 mm) B 1 50 5 Alt: 2 passes at 40

Chipboard 0.022" (0.5 mm) B 2 75 5

Chipboard 0.03" (0.76mm) B 2 95 5

Chipboard 0.06" (1.5mm)
B: left 

R: right

3: on 

both

75: on 

both

1: on 

both

Duplicated image- right side cut / half-blade 

exposure; left side cut at required blade 

exposure; Blade tip ht = 20 Post It notes

Clay
Use a clay press (or pastry 

machine) to make clay thin
B 1 11 10

Make sure pinch wheels will not cross over the 

clay. Blade holder mounted on top of black seat.

Copy Paper Most any brand R 1 30 8

Fabric - Cork embroiderygarden.com B 2 40 5
Blade tip ht = 25 Post It notes; use an extra sticky 

mat and taped around edges. Brayered well.

Faux Leather
~ 1.2 mm thick from Art of 

Fabric Folding (on Etsy)
B 1 50 6

Extra sticky mat w/ material upside down. (mirror 

imagem, as needed)

Faux Leather
AOUXSEEM 1 mm (available 

on Amazon)
B 2 50 8

Extra sticky mat w/ material upside down. (mirror 

imagem, as needed)

Foam - Plain 2 mm B 2 25 10

Foam - Glitter Foamy - 2 mm R 2 15 10

Magnet
Marietta Magnetics - 0.02" 

(0.5mm) (20 mil)
B 2 90 8

Magnet 0.035" (0.9mm) B 2 50 3 Alt: 1 pass at 85

Magnet
Marietta Magnetics - 0.02" 

(0.5mm) (20 mil)
B 2 90 8
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Material Type Material Brand/Source Blade Passes Force Speed Other Comments

Tracing Paper Helix Vellum Paper R 1 30 8

Vinyl - Heat Transfer Siser EasySubli - with the mat R 1 30 8 Cut on the mat

Vinyl - Heat Transfer
Siser Glitter - Gold - No cutting 

mat
R 2 35-40 7

2 passes makes it easier to weed, also slight 

scratch cut in the backing layer

Vinyl - Heat Transfer
Siser Glitter - Gold - with the 

mat
R 2 45-50 7

2 passes makes it easier to weed, also slight 

scratch cut in the backing layer

Vinyl - Wall (no mat) Vinyl - Oracal 631 - yellow R 1 25 8

Vinyl - Wall (on mat) Vinyl - Oracal 631 - yellow R 1 30 8

Vinyl - Waterproof Papilio R 1 30 8
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3. Print and Cut (Contour Cut) 
 

 

3.00 Quick Reference for Chapter 3 

• How to calibrate the camera: Section 3.03.2 

• How to set up a contour cut: Section 3.04 

• How to adjust the camera calibration: Section 3.05.1 

• How to add more registration marks: Sections 3.06.2 and 3.06.3 

• Troubleshooting inaccurate print and cut results: Section 3.05 

• How to set up repeats: Section 3.06.1 

• How to do a PNC from a USB flash drive file: Section 3.07.1 

• How to use the Array Mark function on the control panel: Section 3.07.2 
 
 

3.01 What Is a Print and Cut (PNC)? 

• The print and cut process (also called PNC and contour cutting) involves printing an image from SignCut 
Pro2 to any printer you own and then, with the aid of the Skycut’s camera, have the image or images cut out 
with perfect precision.  Below are three typical kinds of print and cut applications but there can be other 
kinds.  

 Cuts along the actual borders of the printed image(s): 

     

 

 Cuts outside of the borders but follows the shape(s) of the printed image(s): 

      

 

 Cuts follow a different shape from that of the printed image(s): 

Image is precisely cut along 
printed borders 

Image is cut in same shape 
but offset from the printed 

borders (contour cut) 

https://www.youtube.com/watch?v=qAq2-6ZEhEQ&t=158s
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3.02 What is a PNC Calibration? 

• In order to get precise PNC results, you must calibrate the camera. This is nothing more than letting the 
Skycut know how far away the camera lens is located relative to the tip of the blade. Because the camera is 
manually installed inside the blade carriage, the distance from the camera’s center to the tip of the blade will 
vary from one Skycut to the next.  

• This calibration only needs to be done one time. If you have travelled with your Skycut or it’s been bumped 
fairly hard, you might want to run a test to make sure your calibration hasn’t changed. It’s also 
recommended that you check your calibration after any firmware updates are installed. 

• The process, which is conducted through the control panel involves: 

(1) Having the Skycut draw a test shape. At that point the camera takes a photo and displays it on the 

control panel, along with a red + and a large blue dashed +. 

(2) Aligning the red + with the center of the test shape display several times until the blue dashed + is 

centered with the test shape. 
 
 

3.03 Camera Calibration Procedure 
 

3.03.1 What You Need for Calibrating  

• You need the following items for this calibration: 

 Sheet of paper 

 Test pen that came with your Skycut 
 

3.03.2 Calibration Process 

(1) Insert the test pen into the Skycut on the left side blade holder seat. Place the sheet of paper into the 
Skycut. You can use the cutting mat to hold the paper or insert the paper directly. 

(2) Use the arrow keys on the control panel to move the test pen over the sheet of paper. 

(3) Also, on the control panel, if the double head options are displayed, make sure the Use L Head (P0) option 
is selected: 

A custom shape is cut 
around the printed image. 
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(4) Select Speed/Force and set SPEED to ~ 8 and FORCE to ~ 30. Click on Test to verify that a square is 
clearly drawn. If it is too faint, increase FORCE as needed and repeat. 

(5) Move the pen an inch or two away from the test so that there is room for the calibration shape to be drawn. 

(6) On the Main Screen, press Set and then Camera: 

 

(7) Press Adjust to switch to calibrate mode and a new Start button will appear in the lower right corner of the 
Camera Screen: 

 

 

 

 

 

 

Retake photo 

Update blue dashed + alignment 

This is where photo 
will be displayed 

Change brightness of LED light 

 

Adjust is calibrate mode 

Two different screens based 
on Align versus Adjust  Magnify photo by 300% 

Align is normal mode  

Select Use L Head (P0) 
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(8) Press Start. The test shape, which is a square with a + inside, will be drawn on the paper and the camera 

will move over the test shape, take a photo, and display the photo on the control panel. If you cannot see 
the test shape clearly, press the LED button once so that it reads LED 50% and press the Get PIC button. 
You should see three items in the photo: the test shape that was drawn with the pen, a red +, and the blue 
dashed +: 

 

(9) Tap your finger near the middle of the drawn test shape. This will move the red + to that location. Then 
press OK. A new photo will be taken: 

 

(10)  Press X3 so that a magnified version appears: 

… and Start button appears 

Press Adjust button… 

Photo of drawn test shape 

Red + 

Blue dashed + 

Red + is now much closer to the 
middle of the test shape 

Blue dashed + is also much 
closer to the middle of the test 
shape 
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(11)  Use the arrows keys to move the center of the red + to the center of the test shape: 

                

(12)  Press OK and a new photo will be taken. The blue dashed + should now be more closely aligned with the 

center of the test shape: 

 

(13)  If necessary, repeat Steps 10 and 11 until the blue dashed + is near-perfectly centered in the test shape. 

(14)  Press X3 to return to normal magnification. Click on the Home icon to return to the Main Screen. Your 
Skycut is now calibrated for print and cut (PNC) applications. 

 
   

3.04 Performing a PNC in SignCut Pro  
 

3.04.1 Summary of Steps 

• Here are the typical steps when performing a contour cut application: 

It is now much easier to see the 
red +, relative to the center of 
the test shape 

X3 toggles the magnification 
of the image 

The red + is now 
centered in the test 
shape 

Press the arrow 
buttons to move 
the red + 

Note new location 
of blue dashed + 

IMPORTANT: the red + is 
intentionally moved away from the 
test shape with each new photo so 
that you can more easily see if the 
blue dashed + is centered.  
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 Prepare the image(s) that will be printed and cut. These typically include one or more of the following: 

o An imported raster image such as a JPG or PNG or BMP file 

o A vector image (imported, designed in SignCut Draw, or traced from the raster)  

o Text 

 Prepare the appropriate registration marks: 

o Open a template file that has registration marks  

o Have registration marks added in the software 

 Print the project after selecting appropriate printer options.  

 Perform a test cut so that you know the best cut settings to use for the printed material. This test cut can 
often be performed on the printout itself if there is room in the waste area of the project. 

 Perform the cutting process from SignCut Pro2. 
 
 

3.04.2 Preparing the Registration Marks 

• There are two options for adding registration marks in SignCut Draw for use with the Skycut: 

 Option A: Open a template file with registration marks already in place 

 Option B: Add registration marks from within SignCut Draw 

• Both of these will be covered in this section. However, note that currently the first option is the only one 
working correctly with the Skycut models. 

 

Option A. Using a Template File with Registration Marks 

• One of the registration mark templates will be used. These templates can be downloaded from this link: 

• After extracting the files, open either the Letter or A4 file. At this time, do not use one of the templates that 
contains intermediate registration marks. This will be covered in Section 3.06. 
 
 

Option B. Adding Registration Marks from within SignCut Draw 

• While it’s not a requirement, it can be helpful in designing if the Drawing Board dimensions match the 
printout size you plan to use.  For this tutorial, Letter size (8.5” x 11”) will be used. But you can use much 
larger sizes, if you have the ability to print in those dimensions.  

• To change the Drawing Board dimensions, click on the Sign setup icon  on the Tools Panel (or 
press the shortcut W). The following appears on the Properties & Functions Bar: 

 

 

 It’s important to use Margins because the registration marks will be aligned with them. However, on a 
Skycut, these registration marks can be fairly close to the edges of the printout. 

• In this same Sign setup mode, click on the Reg marks option and change settings to the following: 

1. Select Size 

3. Enter Margins 
2. Select from the Presets menu or 
enter custom dimensions 

4. Click on 
Apply 

https://drive.google.com/drive/folders/1ElWPhDpsuVeWFCooO3zt48jADB93kc-g?usp=sharing
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 Distance: This setting can be made smaller if intermediate registration marks are needed. Refer to 
Section 3.06.3.  

 
 

3.04.3 Contour Cutting Project – Accuracy Test 

(1) For the initial testing of a contour cut, it is highly recommended that several arrows be used as they will 

indicate if the camera calibration is accurate.  

(2) Using the same method presented in Section 1.13.3, add several arrows spread out in the Sign Area: 

 

(3) Go to File>Print and verify the following:   

  

 

(4) Click on OK and a second Print window will open where you can select the printer you wish to use. This 

window will vary based on the printer brand and model: 

 

 

 

Print size: choose either 
Letter or A4 to match the 
template you chose 

Select Landscape 

Click on OK 

If the project contains a 
raster image, mark the 
Bitmap option 

If Option B was used to add 
registration marks, mark this 
option 

1. Select Reg  
marks 

3. This should match the Sign dimension 
entered in Step (3).  

2. Select Skycut 
from the Type menu  

4. Click on 
Apply 
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 The Preferences window should always be checked unless you are certain the defaults match your 
needs. This window will also vary by printer but, as an example, here are some settings you may need 
to verify: 

 

 IMPORTANT: Borderless printing can move the registration marks relative to where they are positioned 
in the design project. If you need to activate this setting, please read the following document:  

https://tinyurl.com/y66u5lzf 

 Click on OK and then Print to produce the printout for cutting. 

(5) To transfer the project to SingCut Pro, click on the Move image to SignCut icon  (or shortcut S). The 

cut lines and reigistration marks will appear: 

Click on Print after 
confirming Preferences 

Click on the printer 
you wish to use 

Click on Preferences to 
make other changes before 
printing your project 

Paper size 
Paper type 

Preview, if available, is 
recommended for new 
projects 

Orientation 

https://tinyurl.com/y66u5lzf
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(6) Place the printout onto the cutting mat or load the printout directly if a cutting mat isn’t required.  Note that in 

SignCut Pro, you can use the cut preview window (click on the Cut out icon or press the shortcut I) to 

verify the orientation based on the location of the first reg mark to be scanned:   

    

(7) Load the mat and/or printout so that it is straight, relative to the cutter. The alignment doesn’t need to be 

absolutely perfect but close enough that it will allow for a faster and, of course, successful detection by the 

camera.  Set the Speed and Force (either from within SignCut Pro or on the control panel itself). Insert the 

blade holder and perform a test cut, as needed, adjusting the cut settings.  

(8) Place the blade holder over the first registration mark. In the main SignCut Pro window, click on the 

Contour cut icon .  

(9) Click on Next and the Skycut’s camera will now move over each registration mark, take a photo, and make 
an adjustment. Once it has read all four marks plus the first one a second time, it will proceed to cut out the 
printed shapes.  Note which arrow cuts first because it’s the one that should be used for any adjustment to 
the calibration values. If there is a difference in the offset with the other arrows, that indicates an issue with 
the cut settings. Refer to Section 3.05.3. 

(10)  After testing out this process, be sure to check out remaining sections in this chapter to understand 
additional options, such as: 

 Adjusting camera calibration settings, if needed – Section 3.05.1 

 Other reasons for inaccurate results – Sections 3.05.2 and 3.05.3 

 How to set up a grid of repeats – Section 3.06.1 

 Adding additional registration marks to improve accuracy on long cuts – Sections 3.06.2 and 3.06.3 

 Performing a PNC using the USB flash drive – Section 3.07 
 
 

This corresponds to the 
origin (first reg mark)  

Feed this 
direction into 
Skycut 

This corresponds to the 
origin (first reg mark)  
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3.05 Inaccurate Cuts 

• There are several reasons why your print and cut results may not be as accurate as you need: 

 The calibration needs to be adjusted 

 The contours around the printed image are not accurate 

 The cut settings or pinch wheels need to be adjusted 

• The following sections present solutions for each of these.  
 
 

3.05.1 Adjusting the Calibration Values 

• If you find the first shape being cut is slightly off, you can adjust the values being used versus attempting to 
recalibrate from scratch.  

• To do this, go back to an easy-to-cut material like copy paper and use a shape that has both horizontal and 
vertical lines, such as the arrows that were suggested in Section 3.04.3. This makes it easier to know if you 
need to adjust in the X (left-to-right) direction or in the Y (up-and-down) direction.  

• After performing the print and cut, use a mm ruler to measure how far away the cut lines are from the 
printed lines. If you used an arrow, focus only on the horizontal and vertical lines, not the diagonal lines: 

 

 In this example, let’s say the red cut line is about 0.5 mm too high and about 0.3 mm too far to the left. 
Thus, you need the cut line to move down and to the right.  

• On the control panel, change the Units to millimeters by going to Set>General Settings and choosing 
millimeters, as was shown in Section 1.14.2. 

• Go to Set>Camera and click on Adjust. Then click on Set to open the Adjustment window: 

           
 

1. Press Adjust 

2. Then press Set 

Current 
adjustments 
are set to 0.00 
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• One at a time, adjust Δx and Δy by pressing the buttons in the direction you need the cut line to move.  
 

           
 
 
 
 

• Once the values are set, press the Home button to return to the Main Screen.  Test again to verify the cut 
line is better aligned with the printed shape.  

• Important: You can also adjust calibration numbers after a cut has begun! These adjustments will only 
apply for this particular cut but can be very useful in “saving a cut.” Refer to second part of Section 3.07.3 
for instructions.  

 

3.05.2 Inaccurate Tracings 

• When tracing imported bitmap images, the resulting cut lines may not necessarily follow the original image, 
especially in tight spots.  This can result in tiny bits of white appearing, suggesting the PNC wasn’t accurate.  
Zoom in on the image so that you can see the trace line following the outline of the image. Compare by 
looking at the same spots where the cut didn’t follow the image perfectly. This could be the cause of the 
inaccurate PNC.  There are several ways of handling this situation: 

 Retrace the imported image using a lower Tolerance setting. This should result in a tighter fit around 
the original graphic. Refer to Section 5.01. 

 Use the Node Edit tool  to move the trace lines, where needed, to more closely fit the original 
graphic. Refer to Section 5.02. 

 Create an inset contour cut line to use for cutting instead of the original trace line. 

• Another possibility is that the contour cut line was inadvertently shifted from the graphic to be printed. So, 
check to see if a misalignment may have occurred when you were moving or simply clicking on the design. 

3.05.3 Incorrect Cut Settings 

• If a PNC is not precise and the cause is not the calibration nor the alignment of the trace lines, then go 
through the following check list of other possible causes: 

 Try slowing down the speed.  If the mat is moving numerous times, in and out of the cutter, a slight 
shifting can occur, especially at high speeds. On the Skycut, try a speed of 6 or lower.  

 Verify that the pinch wheels are still centered over grit shafts beneath. Even if one of the wheels is half 
on / half off a grit shaft, it can cause the mat or material to skew slightly. 

Click on these buttons until Δx and Δy  
match the needed adjustments 
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 Make sure the blade isn’t over-extended which can cause it to cut too deeply and drag the cutting mat. 

 Make sure the bottom of the mat isn’t sticky and the pinch wheels and grit shafts are clean and not 
sticky. Clean with a lint-free cloth and a small amount of isopropyl alcohol or Un-Du applied to the cloth. 

 If the print and cut project contains a lot of shapes or the material is thick, try intermediate registration 
marks so that additional scans can occur during the cut.  Refer to Section 3.06.2 for instructions. 

 
 

3.06 Contour Cutting Multiple Images and Adding Intermediate Registration Marks 

• Using intermediate registration marks allows for additional scanning during a contour cut which can 
compensate for any drifting that can occur as a result of friction. This is typically only needed when the 
printouts are very large or the material being cut is thicker or denser than vinyl, paper, or cardstock. 

• Because SignCut Draw does not currently support more than one raster image within a single project file, it 
is necessary to use an alternative program for preparing these kinds of projects. In this tutorial, Inkscape will 
be used. However, a similar process can be used in other graphic programs, such as Adobe Illustrator, 
Photoshop, Affinity Photo, Corel Draw, etc. 

 

3.06.1 Setting Up Multiple Raster Images in Another Program 

• Download a registration mark file from this link. If you want to experiment with the scanning of intermediate 
registration marks, select either of those templates. Note that these are SVG files, not SCD like the ones 
you downloaded in Section 3.04.2.   

• Because SVG is a native file format for Inkscape, use File>Open to import the shapes into a new Inkscape 
file. Other graphic programs will most likely use File>Import. The sole purpose of having the registration 
mark file present is for arranging the images you plan to print and cut, as explained in the next step. 

 

• Use File>Import to open the raster images you want to use in your project. Arrange the images so that they 
are not overlapping the boundary defined by the registration marks. Use the bounding box which appears 
around a selected shape for guidance. Note that allowances should also be made for the size of the contour 
cut:  

                        

 Corner of bounding box around dog 
is just inside the registration mark 

 

Corner of bounding box around cat is 
just inside the registration mark 

 

https://inkscape.org/
https://drive.google.com/drive/folders/19ES3r4X2JTAMp44cHfLuoCItk3e77SHQ?usp=sharing
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• Make duplicates of the imported shapes, as needed. Remember that if an image is too close to a 
registration mark, the camera may confuse the two:  

 

• Delete the registration marks.  Select all of the images and note the dimensions of the project, if you need 
the image to be the same size in SignCut Draw:  

    

• Export the project from Inkscape as a raster file (PNG or JPG) to import into SignCut Draw.  
 
 

3.06.2 Using Intermediate Registration Marks 

• In SignCut Draw, open the registration mark SCD file with the same name as the SVG file used in Inkscape: 

 

• Import the raster file exported from Inkscape using the Import bitmap file icon . Select the second 
option to Adjust bitmap size to current sign size: 

The middle dog was moved up so that the paws 
weren’t so close to the middle reg mark 

 
 

Width and Height of project is noted 
 

 

https://drive.google.com/drive/folders/1ElWPhDpsuVeWFCooO3zt48jADB93kc-g?usp=sharing
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• Select the bitmap image and enter the dimensions to match those in Inkscape (if that is a requirement). 
Drag the project, as needed, to re-center in the Sign Area: 

 

 

• Before adding the contour lines, click on the Select/deselect all layers icon  at the bottom of the Filter 
Colors and Objects Panel until the registration marks are no longer visible (or appear as dashed lines). 
Alternatively, hold the Shift key and left click on the black square.  By deactivating the color black, contour 
lines won’t be placed around the registration marks: 

     

• With the reg marks inactive, use the Create outline on bitmap icon  to add contour cut lines around 
the images. This is covered in Section 5.01.2: 

Select this option 
 

Dimensions changed 
 

 

Drag project, if needed 
 

 

Click here  
 

Registration marks 
are now hidden 
 

Shift + left 
click here 

 
 

or 

Toggles 
show/hide of 
inactive 
shapes  
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• Return to Object edit mode  and restore the registration marks. The project should now appear like 
this: 

 

• Proceed with the printing and the cutting processes, as presented in Section 3.04. The Skycut’s camera will 
scan the following reg marks first and cut only the shapes which are located in that segment.  

   

• The Skycut will then scan and cut the second segment: 

Contour cut lines are 
added around the 
images 

 

The Skycut will scan these 4 reg marks first 
 

This part will cut 
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• If additional registration marks are desired, copy and paste the middle set and relocate to desired locations. 
Note that they do not have to be equally spaced with respect to the others, but do need to be in alignment: 

 
 
 

3.06.3 Automatically Adding Intermediate Registration Marks in SignCut Draw 

• In Section 3.04.2, it was shown in Option B how to add registration marks without opening a template.  
Intermediate registration marks can be added in a similar way. However, at this time, these registration 
marks are not recognized as such in SignCut Pro.  

• In this tutorial, a large number of repeats are going to be printed and cut. Adding intermediate registration 
marks ensures greater accuracy through the progression of the cut. 

 

• Adding intermediate registration marks ensures greater accuracy through the progression of the cut. In this 
project, it is decided to add marks ~ every 4 inches. 

The Skycut will then scan these 4 reg marks  
 

This part will then cut 
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• To add the registration marks, click on the Sign setup icon  on the Tools Panel (or press the shortcut 
W).  Mark the Reg marks option. The following appears on the Properties & Functions Bar: 

  

 Select Skycut from the Type menu.  Entering the spacing (in this example, 4 inches) into the Distance 
field. Click on Apply:  

 

 Intermediate registration marks are added to the project. Note that while the marks appear as red 
outlines, they will print solid black.  

 There is an option to hide the marks on the screen by toggling the View registration marks option on 
the View Bar: 

 

 

• IMPORTANT: Using the Array plus Array Mark options on the Skycut’s control panel allows for more 
flexibility when working with multiple registration marks, such as being able to only scan one mark when 
there are repeats. This is covered in Section 3.07.2.  

 
 
 

3.07 PNC from USB Flash Drive 
 

3.07.1 PNC from Flash Drive – Single Cut 

• To perform a print and cut project from the control panel, first perform Steps (1) – (7) from Section 3.04.3. 
The project will now appear in SignCut Pro: 

1. Select Reg  
marks 

3. Change the Distance 
to the desired spacing  

2. Select Skycut 
from the Type menu  

4. Click on Apply 

View registration marks 
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• Hold the Shift key and left click on the Contour cut icon .   This will open the Save as window where 
you can save the job as a PLT file on a USB flash drive inserted into a port on your computer: 

  

 

• On the Skycut’s control panel, set the Force and Speed, if you elected not to have them activated on the 
Tool Settings tab in SignCut Pro. 

• Go to Set>Camera.  With Align selected, press Set and the following window will open: 

    

 Verify that AutoMark box is checked. Then click on Home. 

1. Align should 
be red 

2. Then press Set 

Check 
AutoMark box 

Select the USB  

flash drive 

Name the file 

Click on Save 
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• Insert the flash drive into the right side of the Skycut and use the instructions in Section 1.12.4 to open the 
file into the Skycut: 

 

• Click on Start Cut and the marks will be scanned by the camera and the shapes cut out. 
 
 

3.07.2 PNC from Flash Drive – Using Array Mark for Repeats 

• The Skycut has the ability to set up an array of repeats for PNC applications. The advantage to using the 
Skycut’s control panel for this process is that the Array Mark function permits the scanning of additional 
registration marks as repeats are cut. This is far more accurate than only scanning the original four marks 
on significantly large projects: 

 

• The Array Mark window on the control panel can be opened in two ways: 

• Go to Set>Advanced Settings>Array>Array mark 

• Go to USB>Array Set>Array mark 

• In the Array Mark window, you have three options: 

• 4 Mark: Scan all four marks on every repeat 

 

Press Start Cut 

File name should 
appear here 

Reg marks 
printed around 
each repeat 

One set of reg marks 
on a large PNC 
project 
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• 1 Mark: Scan first four marks on first set only. Then scan one mark only on each remaining repeat 

               

 

• Alternate:  

       

 

 

    

 

 

Alternate between scanning all 4 
marks and scanning only 1 
mark, based on a set Interval 

Combination of 4 Mark 

and 1 Mark options 

Interval set to 1: 

1. Four marks in green set are scanned first and 
first three shapes cut. 
 

2. Single mark by orange arrow scanned, next 
three shapes cut. 

 

3. Single mark by purple arrow scanned, next 
three shapes cut 

 

etc. 
 

1. Four marks in green set are scanned first 
and first three shapes cut. 
 

2. Four marks in orange set scanned, next three 
shapes cut.  
 

3. Four marks in purple set scanned, next three 
shapes cut. 
 

etc. 
 

1. 1. Marks in green set scanned and first three shapes cut.  
2.  

3. 2. Single mark by the orange arrow scanned, next three shapes cut.  

4.  

5. 3. Marks in purple set scanned, next three shapes cut. 

6.  

7. 4. Single mark by blue arrow scanned, next three shapes cut. 

8.  

etc. 
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Interval set to 2                  

  

 

• When choosing an Array Mark option, keep the following in mind:  

• The purpose of having intermediate scans is to correct for any slippage that occurs due to friction or 
excessively fast cutting speed. 

• Use 4 Mark in situations where the repeats are quite large, thus there’s a larger distance between 
the repeats and slippage is more likely to occur. It’s also a good option when cutting thicker 
materials because the higher force applied by the blade can cause more drag on the material or 
cutting mat. 

• Use 1 Mark in situations where the material is thin, the cuts are simple, and the distance between 
the repeats is relatively small. Obviously, this is the most time-efficient choice of the three options 
since a 4 mark scan is only performed one time. 

• Use Alternate as a compromise between the other two options. Experience will determine how high 
of an Interval can still yield the accuracy you need. 

 
 
3.07.3 Mark Set Options 

• The Mark Set window has the following two applications: 

 Select a specific range of images to cut versus the entire project file. 

 While the cutting is underway, if you observe that the accuracy is off, you can immediately pause the 
cutter and tweak the calibration for just that particular cut. 

• To select a specific range of images, note the following: 

 The first set to cut is referred to as M0 and then subsequent sets are M1, M3, M3, etc. 

 In the Mark Set window, select Custom and then enter the start and ending sets. For example, if you 
want to start with the second set and end with the seventh, you would change to M2 and M7: 

1. 1. Marks in green set scanned and first three shapes cut. 

2.  

3. 2. Single mark by orange arrow scanned, next three shapes cut. 

4.  

5. 3. Single mark by purple arrow scanned, next three shapes cut. 

6.  

4. Marks in blue set scanned, next three shapes cut. 

 

etc. 
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 The resulting sets will be sent versus the entire project: 

 
 

• To tweak the calibration after a cut has begun: 

 Press the Pause button on the Home screen to immediately stop the cutting. 

 Press the USB button on the Home screen. 

 Press the Mark Set button. 

 Check or uncheck the adjust Immediately option based on the following: 

o Check the option if you want the adjustment to be made on the current shape that was being cut 
when you paused the Skycut. Note that the start and end point on that path will not completely 
close, as a result. 

o Do not check the option if you want the adjustment to be applied on the next shape that will be cut.  

 Click on the arrow buttons to adjust the Δx and Δy by the amount and in the direction you need the cut 
line to move: 

Select Custom 

Default settings 

Select + and – 
buttons to change 
start and ending sets 

M7 

With M2 and M7 
entered, these sets will 
be cut 

M6 

M5 

M4 

M3 

M2 

M1 

M0 
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 Once you have entered the Δx and Δy values you wish to use, press the Go on button and the cutting 
will resume. 

• Important:   

 If you need to make yet another adjustment, repeat the process.  The new Δx and Δy you enter is only 
an adjustment based on what you are now needing. For example, based on this example, if you need Y 
to move another 0.2 mm in the same direction, you would enter 0.2, not 0.4 mm.  

 Remember that the adjustment is reset at the conclusion of the cut. If you want permanent changes, 
adjust the calibration numbers using the process presented in Section 3.05.1.  

 

 

  

Adjustments to be 
made to cut line 

Click the arrow buttons to move the 
cut line in the direction needed. 
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4. Accessory Tools and Dual Head Calibration 
 
 
 

4.00 Quick Reference for Chapter 4 
 

• How to calibrate an accessory tool with the blade holder or other tool: Section 4.01 

• How to draw with the test pen and cut around the drawing: Section 4.02.1 

• How to score and cut a fold-up project: Section 4.02.2 

• How to emboss cardstock: Section 4.02.3 

• How to engrave a metal tag: Section 4.03.1 
 
 

4.01 Dual Head Calibration 

• IMPORTANT: Before proceeding with any dual head applications, note the following setting which needs to 
be changed in SignCut Pro2 in order for the right side to be used when assign Tool2 with any particular 
color of shapes: 

 In the Cut out window, on the Cutting tab, select D24 from the Choose cutter preset menu:  

 

• In Section 3.03, the camera calibration was presented showing how to make sure the blade holder is 
calibrated with the camera. A similar calibration is also needed to make sure the right and left blade holder 
seats are perfectly aligned with one another. This then allows you to do accurate draw-and-cut, score-and-
cut, engrave-and-cut, and other combined tool applications.  

(1) On the control panel’s Main Screen, make sure the Use Double Head option is selected. If you do not see 
any of these options, click on Set>Advanced settings>System mode and select double. Then, back on 
the Main Screen, the options should now be available: 

 

 

 

 

 

 

Cut out window 

Cutting tab 

 Select D24 
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(2) Insert a sheet of paper into the Skycut, either on the cutting mat or directly inserted. Load a test pen into 
both the left and right side blade holder seats, making sure the pen nib is a little ways above the paper, as 
you did in Section 1.13.  You can also use a stack of 35 Post It notes as presented in Section 2.01.3. 

(3) Select the Speed/Force function and make sure both sides are set to a suitable Force for drawing: ~ 30 – 
40.  

(4) Make sure both pens are over the paper. On the Main Screen, select Set>Camera to open the camera 
calibration screen: 

 

(5) Press Adjust to switch to calibrate mode and a new Start button will appear in the lower right corner of the 
Camera Screen: 

Select Use Double Head 

Retake photo 

Update blue dashed + alignment 

This is where photo 
will be displayed 

Change brightness of LED light 

 

Adjust is calibrate mode 

Two different screens based 
on Align versus Adjust  Magnify photo by 300% 

Align is normal mode  
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(6) Press Start. A test shape, which is a square with a + inside, will be drawn by the right side pen on the 

paper and the camera will move over the test shape, take a photo, and display the photo on the control 
panel. If you cannot see the test shape clearly, press the LED button once so that it reads LED 50% and 
press the Get PIC button. You should see three items in the photo: the test shape that was drawn with the 
pen, a red +, and the blue dashed +: 

 

(7) Tap your finger near the middle of the drawn test shape. This will move the red + to that location. Then 
press OK. A new photo will be taken: 

 

(8)  Press X3 so that a magnified version appears: 

… and Start button appears 

Press Adjust button… 

Photo of drawn test shape 

Red + 

Blue dashed + 

Red + is now much closer to the 
middle of the test shape 

Blue dashed + is also much 
closer to the middle of the test 
shape 
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(9)  Use the arrows keys to move the center of the red + to the center of the test shape: 

                

(10)  Press OK and a new photo will be taken. The blue dashed + should now be more closely aligned with the 

center of the test shape: 

 

(11)  If necessary, repeat Steps (9) and (10) until the blue dashed + is near-perfectly centered in the test shape.  

(12)  Now move the red + so that it is perfectly aligned with the center of the blue dashed +:  

 

 

 

 

It is now much easier to see the 
red +, relative to the center of 
the test shape 

X3 toggles the magnification 
of the image 

The red + is now 
centered in the test 
shape 

Press the arrow 
buttons to move 
the red + 

IMPORTANT: the red + is 
intentionally moved away from the 
test shape with each new photo so 
that you can more easily see if the 
blue dashed + is centered.  
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(13)  Press OK and the camera will move to the left side test square and will post an image. Repeat Steps (7) – 
(11).  

(14)  Once the blue dashed + is near-perfectly centered in the test shape, click on the Home icon to return to the 

Main Screen. Your Skycut is now calibrated for dual head applications. 
 

 
 

4.02 Drawing with the Test Pen 

• With the Skycut, you can draw shapes and lettering with the test pen. If you wish to fill (i.e. color in) a shape, 
SignCut Draw offers a Hatch Fill function. Refer to Section 5.03 for instructions on how to adjust settings to 
create a line fill. 

• Do not have the pen positioned too low in the blade holder seat or the tip of the pen could drag across the 
paper when moving from one shape to the next.   Thus, use the same 35 Post-It note method as with the 
blade holder. 

• Make sure your shapes will not be drawn where any of the pinch wheels travel over the material. Otherwise, 
the ink might smear.  

 

4.02.1 Draw and Cut 

• A draw-and-cut application involves using a pen to draw shapes and using the blade holder to cut them 
out… all in the same process.  This rest of this section covers the process.  

• In the following example, a vector flower file has been imported into SignCut Draw and sized for the project: 

 

• To add a contour, select the Effects icon  on the Tools Panel or press the shortcut A1.  Make the 
following changes on the Properties & Functions Bar:  

 

Move red + to align 
with center of blue 
dashed + 

Mark the Contour 
option 

Outside should be selected 

Click on Apply  

Mark Keep original 

Enter Contour size Mark Separate Inner 

https://drive.google.com/file/d/18yInyDVF-d0eeA0mbYdtboXsYyb-Zv1o/view?usp=sharing
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• The flower now has a contour path around it. However, the Select by color panel indicates there are three 
colors present: 

    
 

• The white shapes are the separate internal contour paths that were also created. To better illustrate their 
presence for this tutorial, they are recolored green: 

 

• Since these internal paths won’t be cut, select and delete them leaving the colors red and grey.  

• Send the project to SignCut Pro and go to the Cut out window and click on the Advanced settings tab. 
The two colors will appear in the list and will be processed in the order shown. Because it makes more 
sense to draw first and cut second, the grey layer will be moved down. This is done by selecting the grey 
layer and clicking on the down arrow as shown: 

            

 

• Normally when cutting different colors, you would proceed to click on Edit attributes (at the bottom of the 
prior screenshot) for each color and enter the required Cutting force, Cutting speed, etc. However, 
because a pen doesn’t require a Blade Offset setting, but the blade does, it is necessary to create presets 
for each color that will then be assigned to the red layer that will be drawn by the pen and the grey layer that 
will be cut with the blade. Refer to Section 2.04.1 

Click the down arrow 

Select grey 
layer 

Red will be 
processed 
before grey 

Check this 
option 

Select Advanced settings 

Contour line 

White, grey, and red 
shapes are present 

Original red flower 
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• With the presets added, separately select each color and click on Edit attributes. Select the preset for that 
layer.  Change the Tool setting to Tool 2 for the red layer so that the right side will be used instead of the 
left (which is Tool 1). Note that assigning Tool 2 could have been done when creating the preset.  

     

 

• Mount the blade holder on the left side of the Skycut D and the test pen on the right side. Load the cutting 
mat into the Skycut and set the origin based on the left side blade holder (or use the camera method 
presented in Section 2.05.1). Click on Cut out and the Skycut will draw the design with the test pen and cut 
it out with the blade holder. 

 
 
 

4.02 Embossing and Scoring 
 

4.02.1 General Info on Embossing 

• The Skycut embossing tool has two different sized embossing heads. The smaller one is recommended 
when scoring cardstock for fold-up projects, such as pop-up cards, gift bags, and small boxes. Either head 
can be used for embossing shapes. 

 

• When embossing cardstock, it is recommended that a soft material be place beneath the paper or cardstock 
to allow a deeper impression to be made. One excellent material to use is non-slip shelf liner.  Other 
materials which can be used include rhinestone rubber, craft foam, and felt. Make sure the material is well 
adhered to the mat (tape it down, if necessary). Then tape your paper or cardstock to the top of this 
material. 

• When using the embossing tool for scoring fold-up projects, the paper or cardstock can be applied directly to 
the mat, just as you do for cutting. This makes it much simpler when you need to score and then 
immediately cut. Because the scoring may not be as deep on the underside of the paper or cardstock as the 
top side, fold all score lines (valley and mountain) forward to establish the fold on both sides. Then flip over 
and fold any mountain folds the opposite way. This especially works well on pop-up cards. 

• Make sure you do some tests first to get the best settings for the scoring or embossing.  For scoring 
cardstock, this typically involves a higher force (~160) and two or three passes.  Refer to the Suggested 
Settings table at the end of this chapter. If you have a soft material beneath your paper/cardstock, then a 
lower force will be used, but you may still need several passes. Also, to get more force applied, raise the 
tool in the blade holder seat the same way you do with the blade holder (i.e. 20 Post-It notes). 

 

4.02.2 Score and Cut Project  

• When a project involves both scoring and cutting, the same process presented in Section 4.02.1 is followed.  
For testing, try out this foldup box which can be downloaded here. 

Change to 
Tool 2 

Select preset for drawing red layer Select preset for cutting grey layer 

https://drive.google.com/file/d/1mWbm7JEBGdrOyAn3ovJZXEhmUTPljj1-/view?usp=sharing


 120 

 

• As with a draw-and-cut application, the score lines should be a different color from the cut lines. Note that 
because the two rectangle scores are closed shapes, they are listed separately on the Select by color 
panel and will be treated as separate colors when assigning the settings in SignCut Pro: 

 

• After sending the project to SignCut Pro, open the Cut out window and note the following steps which were 
used in the Draw and Cut tutorial: 

 On the Tool settings tab, create separate presets for the scoring and cutting steps making sure the 
Blade Offset is set to 0 for the scoring tool. You may wish to also assign the scoring tool preset to Tool 
2 so that the right side will be used without needing to remember to change it in the Edit Attributes 
window.  Refer to Section 2.04.1 for directions on creating presets. 

 On the Advanced Settings tab, mark the option for Cut in colour order and move the score layers 
above the cut layer. 

 For each layer, click on the Edit attributes tab and select the appropriate preset from the drop-down 
menu.  

 Mount the blade holder on the left side of the Skycut D and the test pen on the right side. Load the 
cutting mat into the Skycut and set the origin based on the left side blade holder (or use the camera 
method presented in Section 2.05.1). Click on Cut out and the Skycut will score the fold lines with the 
embossing tool and cut out the design with the blade holder. 

 
 

4.02.3 Embossing Paper or Cardstock 

• When embossing paper or cardstock, it is recommended that you use contours to create several very small 
outlines with a spacing of, say, 0.01” (0.25 mm). These tiny offset lines will then produce a slightly thicker 
overall outline of your shapes. This works better than line-filled embossing which can stress the cardstock 
and cause wrinkling. Here are the steps: 

 Create the shape you wish to emboss. In this example, the number 25 is used: 

 

 Select the shape and click on the Effects icon  (shortcut A) and select the Contour option. On the 
Properties & Functions Bar, enter the settings for the two contours: 

Outside box cut line 

Open path score lines 

Closed path (rectangle) score lines 
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 Now you have three versions of the shape, each one slightly outset from the other.  Thus, when using 
the embossing tool, this will result in a thicker outline made of this shape.  

 Important: don’t forget to mirror the image so that when you flip over the cardstock after embossing, the 
design will “read correctly.”   This can be done in one of two ways: 

o In SignCut Draw, click on the Mirror horizontally icon   

o In SignCut Pro, click on the Mirror image icon  

 
 

4.03 Scratch Engraving 

• The Skycut engraving tool can be used to engrave vellum, foils, acrylic, and most metals, including trophy 
labels, dog tags, and jewelry charms. 

 

• On softer metals, you may not want the engraving tip too far above the metal as it can leave pock marks 
when it drops to start engraving. If possible, test on scraps first. 

• Refer to the Suggested Settings table at the end of this chapter for Force and Speed settings on various 
materials. Note that in some cases you may want to use more than one pass for a slightly deeper engraving. 

• To design an engraving fill pattern, use the instructions in Section 5.03.  

 

4.03.1 Engraving a Metal Tag 
 

 

• When engraving items that are already cut (such as metal tags, trophy plates, charms, etc.), it’s very 
important to have precise alignment before proceeding.  Therefore, the camera on the Skycut will be used to 
set the origin for engraving. If you haven’t already calibrated the camera, go to Section 3.03. 

• The following is a list of the items you’ll need for this kind of an application: 

 The item to be engraved 

 The Skycut engraving tool 

 Double sided tape to secure the item to the cutting mat. Thermo-web is perfect for this. 

• Create a replica of the item to be engraved: 

 If it’s something simple, like a square or a rectangle, use the basic shapes available in SignCut Pro: 

          

Photo of actual tag Replica of tag created 
using two circles 

Mark the Contour 
option 

Mark Outside for Contour 1 
and Contour 2 

Click on Apply  

Mark Keep original 

Enter the Contour offsets 

https://www.amazon.com/Therm-Super-Tape-roll-PACK/dp/B00DUGYHN2/ref=sr_1_16?ie=UTF8&qid=1531005087&sr=8-16&keywords=thermoweb+tape
https://www.youtube.com/watch?v=gIHJueG2kco
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 If it’s not a shape that can easily be recreated in SignCut Draw, then trace it onto paper: 

 

 Scan or photograph the trace and use the instructions in Section 5.01 to import the scan and create a 
contour of the heart: 

 

 

 

• IMPORTANT: Carefully measure the actual tag and compare it to the dimensions of the contour. Adjust the 
size of the contour if needed. 

• Create the design to be engraved. In this case both text and a vector shape of a bone are added: 

 

• Because a filled engraving is desired, select the text and the bone shape and use the Hatch Fill effect to fill 
the design with lines.  Details on this function are presented in Section 5.03.1. The color of the outside tag is 
changed since it won’t be sent to the Skycut: 

 

 

• On the Skycut, the metal tag needs to be very firmly attached to the cutting mat. Place strips of double-sided 
tape onto the mat, where the tag will be mounted: 

 

• When placing the tag onto the mat, align the bottom side of the tag with a vertical grid line and the left side 
of the tag with a horizontal grid line. The intersection of the two gridlines will be the origin for the engraving 
process: 

Double sided tape is placed on the 
mat to cover the size of the tag (note: 
the pink liner hasn’t yet been removed 
from the top of the tape) 
 

Imported scan Tracing from Create 
outline on bitmap 
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• Load the mat into the Skycut and be very precise in alignment by using the cutting strip to make sure the 
mat is perfectly straight on both sides: 

      

• Load the engraver into the Skycut using 15 Post-It notes, making sure the notes are on top of the tag so that 
the tip is clearly above the tag.  

• Move the cutting head so that the engraver tip is over the intersection of the two grid lines bounding the tag. 
Then use the camera instructions in Section 2.05.1 to set the origin even more precisely by getting the blue 
dashed + in the middle of the grid intersection: 

 

• After clicking on Home, press down on the engraver and verify, once more, that the correct grid intersection 
was used.  

• Back in SignCut Draw, send the design to SignCut Pro. Note that it’s very important to include the outside 
tag color since it defines where you want the engraving pattern to be made: 

Align the tag with the grid 
lines on the mat 
 

The origin will be set at this intersection 
 

Blue dashed lines cross at 
grid intersection 

Align the mat on both sides 
with the cutting strip 
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• Left click on the black color and the heart will no long appear but the shapes to be engraved will retain their 
same position relative to the heart: 

 

 

• Click on the Cut out icon and select the Tool settings tab.  Note the engrave pattern shows the position 
and orientation relative to the origin you set on the Skycut: 

 

• Enter the settings for engraving and create a preset, if desired:  

The heart tag shape needs to be present, 
even though it’s not sent to the cutter 

Click on the black color so 
that it’s the only one to be 
sent to the cutter 

The shapes to be engraved have not 
changed position 

Origin  
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• After entering all settings, click on Cut out and the engraver will engrave the pattern onto the metal tag:  

 
  

Mark this option 

Enter Force and Speed 
for engraving 

Leave these set to 0 

Enter Passes 

Click on Cut out to start 
the engraving process 
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4.05 Settings Form for Accessory Tools 
 

Application/Material Tool Force 
Speed 

(Cut/Up) 
# 

Passes 
Surface Other Comments 

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

© 2009- 2020 Sandy McCauley, All Rights Reserved 
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5. SignCut Draw Functions of Interest 

 
 
 

5.00 Quick Reference for Chapter 5 

• How to add a contour cut: Section 5.01 

• How to edit a contour cut: Section 5.02 

• How to fill a design with engraving lines: Section 5.03 

• How to convert a photo into an engraving project: Section 5.03.4 
 
 
 

5.01 Adding a Contour Cut Line to a Raster Image 

• Graphics such as JPG, PNG, and BMP files are often used for print and cut (contour cut) applications. 
Because these types of files are raster images (versus vector images), the images must be traced. This is 
done through a process called vectorization.  

• The Bitmap tool  (shortcut I) on the Tools Panel provides the necessary functions for importing a 
raster image and performing automatic tracing.  When activated, the Properties & Functions Bar initially 
displays these options: 

 
 
 
 

5.01.1 Importing an Image to Trace      

• To begin the tracing process, click on the Open bitmap file icon  and an Import window will open. 
Browse to the folder containing the bitmap image you wish to open and trace: 

 

 

Import image 
Section 5.03.1 

Apply 

Image adjustment options 
 

Trace options 
 

Browse to 
locate folder 

Click on Open  

Click on the file and 
it will appear under 
File name: 



 128 

• If you tend to keep raster images in one particular folder, then holding the Shift key while clicking on the 
Open bitmap file icon will open a Bitmap window where you can set up a Favorites folder. 

• Note that you can also copy/paste bitmap images from what’s been copied onto the Windows clipboard 
(such as from Google images) into SignCut Draw.  

• After selecting a file and clicking on Open, a popup window will provide two options: 

 

 Either choice is acceptable since both the bitmap and the Sign Area can later be changed. If the first 
option is selected, then the margin boundaries of the Sign Area will now touch the bitmap boundaries: 

 

 If the second option is selected, the bitmap is sized to fit whichever dimension (X or Y) constrains the 
shape:   

 

 

 Note that the image will not extend beyond the green-dashed margins inside the Sign Area. 
 
 

5.01.2 Step-by-Step Tracing Process 

• While SignCut Draw offers several methods for vectorizing imported images, the easiest one for creating a 
contour cut line is the Create outline on bitmap function. 

• For this tutorial, an example of tracing an image for a contour cutting (print and cut) application is chosen: 

Resize the Sign Area 
dimensions to match 
the bitmap dimensions Resize the bitmap dimensions to 

match the Sign Area dimensions 

Option 1: Adjust sign 
size to original 

bitmap size 

Option 2: Adjust 
bitmap size to 
current sign size 
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• After importing the bitmap, click on the Create outline on bitmap icon  and the following additional 
settings appear:  

 
 

• The Distance setting is how far the trace line will be placed from the borders of the image: 

 If you want the trace line to follow the print line, set Distance to 0: 

 

 If you want a contour cut around the printed image, such as used for stickers, set the Distance to a 
positive number: 

 

 If you want an inset cut line which is often used to allow for some error when cutting along the print line, 
set the Distance to a small negative number, such as -0.02 inch (-0.5 mm): 

Adjust sharp turns in the tracing 
 

Offset from image borders 
 

Create outline on bitmap 
 

Blackout option (no internal shapes) 
 

Apply 
 

Trace line follows the 
printed image 

Distance set to 0 

Trace line is offset from 
the printed image 

Enter a positive Distance 
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 To apply the settings, click on the Create All icon. The orange dashed lines will change color and will 
no longer be dashed, indicating the tracing is now set. To hide the original imported image, click on the 
Hide Bitmap icon. You will then see what lines will cut with these settings: 

 

 For contour cutting, the internal cut lines are typically not needed.  To omit them, first click the Undo 

button  at the top of the screen to back up a step. Next, click on the Create outline bitmap icon 
again, and mark the option for Outer only. Click on Create all. You will still see the internal trace lines, 
however, once you hide the original bitmap again, you’ll observe the internal cuts are now removed: 

    

• If the trace lines are not fitting the original bitmap to your satisfaction, a Threshold setting can be adjusted. 

To do this, click on the Black and white icon and the Tolerance setting will light up and be adjustable: 

Trace line is inside the borders 
of the printed image 

Enter a negative Distance 

Click here to hide imported bitmap 

Mark this box to remove 
internal trace lines 
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 If a tighter fit is needed, lower the Threshold setting and more nodes will be added.  If a looser fit is 
needed, raise the Threshold setting and fewer nodes will be used. 

 Note that clicking on the Apply icon above the Threshold setting will allow you to examine the trace 
before clicking on Create all. Thus, you can continue to make changes to Threshold until you are 
satisfied with the results. 

• Additional vectorizing functions and settings are available in SignCut Draw. Refer to the SignCut user 
manual. 

 
 

5.02 Editing a Trace 

5.02.1 Node Editing a Contour Cut 

 In the following example, it’s discovered that there are a few gaps between the trace line and the bitmap 
that resulted in some white showing during a contour cut. Here’s one example: 

     

 With the trace line selected, click on the Node Edit icon  (or shortcut O) and the nodes making up 
the path of the cut will appear.  Drag nodes, as needed, to move the path within the print area: 

     

o Nodes can be individually moved or together at one time. In the prior screenshot, the Shift key was 
held so that two nodes were selected and then dragged together to move the path. 

4. Click on Create all 

1. Click on 
Black & white 

3.Click on Apply 

2. Threshold can now be changed 

Slight gap at 
this spot 

Zoomed in 

Select both 
nodes 

While dragging nodes, both 
current path and new path 
are visible 

Path is now inside 
bitmap image 
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o Node editing in SignCut Draw offers many more features which are covered in the SignCut user 
manual. 

 
 

5.02.2 Deleting Paths Within a Contour Cut Trace 

 In the following example, a crab cartoon from Doodle Dragon Studios is traced: 

 
 

 The issue in this example is that the space below the eyes should be cut out but not other internal 
shapes, such as the pupils of the eyes. Note the difference in what will be cut between marking and not 
marking the Keep Holes option in the Create Cut-Contour window: 

 

         

 

 

 The first option, Outer only, needs to be left unchecked so that the area beneath the eyes is traced. 
After creating the trace, click on the Object edit icon to return to the main screen. Click on the View 
Bitmap icon to hide the bitmap image:            

      

 

 Select the tracing and click on the Ungroup icon  on the Properties & Functions Bar (or press 
Ctrl+U). You can now individually select the shapes you want to remove and press the Delete key. 

 

Outer only 
marked 

 

Area below eyes is traced but so are 
the inner parts of the eyes 

 

Outer only not 
marked 

 

No inner paths at all 
 

 

versus 
 

 

Click this icon to hide 
the bitmap image 

 
 

An outside trace is 
needed 

Also needed is a trace of 
this area between the eyes 
and the body 
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 You may wish to now reselect the outer and inner shapes and apply either a Create group (Ctrl-G) or 
Combine objects (Ctrl-L): 

 
 
 
 

5.03 Engraving Fills 
 
SignCut Draw offers a number of different options to create engraving fills.  The following sections cover each 
type.  
 

5.03.1 Hatch Fill 
 

• The Hatch Fill effect will create a linear fill that can be single-line or double-line (hatched): 

   

• To add a linear fill, select the vector shape and click on the Effects icon  on the Tools panel (or press 
the shortcut key A). Mark the Hatch option and the Properties & Function Bar will now have the following 
settings and options: 

 
 

 
 

• Select the desired angle for the first line from the drop-down menu. Below, in the Radius 1 field, enter the 
desired spacing between the lines. Normally, with a tool such as the Skycut engraver, a very small value 
would be used, such as 0.1 mm (or 0.004”). However, to better illustrate the effect for the screenshots used 
in this tutorial, a much larger value has been entered.  Click on the Apply icon to accept the settings: 

    
 

• As with other functions in SignCut Draw, if you want to make changes, use Undo to back up. Then change 
the settings, as desired. Perhaps you prefer a different angle: 

Combine objects 
 

Create group 
 

Select Hatch 

Engraving settings for first 
set of lines 

Click on Apply  
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• To add a second set of lines for a hatch fill, select a different angle from the Angle 2 drop-down menu and 
enter the desired spacing in the Radius 2 field: 

    

• The Overlap setting is typically used with rotary tools where the exactly diameter of the tool is known. That 
is entered into the Radius field(s) and the Overlap is usually set to half that radius (or more) to make sure 
there are no gaps when the engraving occurs, assuming a complete fill is the goal:  

 

 

 

• The Contours option will add both an inset and and outset contour line of the original shape with the 
spacing equal the value set in Radius 1: 

    

• Alternatively, if you mark the Contours option a second time, the option changes to Inline and the smaller 
internal shape is the result:   

    

• The Connect option controls whether or not the tool stays down or rises at the end of each line. Thus, 
marking this option will result in lines connecting which can decrease the amount of time taken for the 
engraving to occur. With the outside border still present, it isn’t apparent that the lines are connected. 
However, if you drag the original star outline away, you’ll observe the difference: 

Mark Contours 

Both inset and outset 
lines are added  

Mark again to change to Inline 

This is the Inline result  Versus the prior version with 
the original and outset lines 

Enter Radius 
of tool  

Enter desired Overlap  
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5.03.2 Contour Fill 

• The Contour Fill (sometimes referred to as an island fill) is a progressive inset pattern based on the original 
shape; the tool drops to complete a path, raises, moves to the next path, drops to complete that path, etc. 
Some shapes work better than others with the Contour Fill: 

   
 

• To add a contour fill, select the vector shape and click on the Effects icon  on the Tools panel (or 
press the shortcut key A). Mark the Contour option and the Properties & Functions Bar will most likely 
look like this: 

 

 
 

• Click several times on the check box next to Outside, under Contour 1 until it changes to Fill: 
 

 
 

• Below Fill, enter the desired spacing between the lines. Normally, with a tool such as the Skycut engraver, a 
very small value would be used, such as 0.1 mm (or 0.004”). However, to better illustrate the effect for the 
screenshots used in this tutorial, a much larger value has been entered.  Click on the Apply icon to accept 
the settings: 

  

Without Connect option marked:   

Individual lines  

With Connect option marked:   

Lines are connected 
where possible  

Engraving settings 

Click on 
Apply  

Select 
Contour 

Click here to change to Fill 
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• With a smaller tool, the gaps seen in the prior screenshot will not necessarily be present. Thus, test out the 
actual settings you plan to use. Note that with a very small spacing, it can take a number of minutes for the 
pattern to be rendered.    

• As with the Hatch Fill feature, an Overlap setting can be applied if the radius of a rotary tool is entered 
instead of the desired spacing:  

    
 
 
 

5.03.3 Inside Fills Versus Outside Fills 

• In certain situations, you might want to reverse the parts of a design that are filled. To do this, add any 
outside shape to the design, such as a rectangle, an oval, a heart, etc. Select both the inside and the 

outside shapes and apply Combine objects (Ctrl-L)  

• With the combined shapes selected, apply the Hatch fill function and the space between the original shape 
and the added outside shape fills with the lines: 

 For example, if three stars have the Hatch fill applied, the result appears like this: 

 

 However, if a rounded rectangle is added around these stars and Combine objects applied, then a 
Hatch fill results in this: 

 
 
 

5.03.4 Line Raster from Bitmap 

• The name of this trace option suggests a raster file is being created, however the result is actually a vector 
shape made up of a particular pattern of lines that are spaced in such a way that the result appears to be a 
raster image.  

   

Mark Overlap option 

Enter Overlap amount  More contour lines are added 

Original photo Line raster from bitmap 
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• Note that flat colored clipart would not be suitable for this type of trace as the effect is dependent on 
variations of light and dark pixels.  

• After importing a bitmap image, click on the Create line raster from bitmap icon  and the following 
window opens. However, note that the window will change settings depending on which Application option 
is selected in the top row. 

 
 
 
 
 

 

 The three Application options create three different types of patterns, as shown here: 
 

   
 

 When zoomed in at ~200%, and with Show Fill turned off, you can see the differences in the type of 
vector “cuts” that will be made.  

   
 
 
 

 After selecting the desired Application and entering appropriate settings, click on Create. Depending 
on the settings chosen and the size of the bitmap image, it can take quite some time to generate the line 
pattern.  It’s often best to do something else while waiting: make a cup of coffee, respond to a few 

emails, pet your dog.        

Settings to be covered 
(will vary by Application) 

Settings to be 
covered (will vary by 
Application) 
 

Click Create after selecting 
option and settings  
 

Application options 

Cut lines option Diffused lines option Engrave lines option 

Cut lines option Diffused lines option Engrave lines option 
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 Once the line pattern is created and the window is closed, the image on the screen will still have the 
imported raster visible. Hide the raster, as needed, to view the results of the trace.  

• The Engrave lines option is further described here as it is used in scratch engraving applications. It can 
also be used with other tools such as pens and markers.  Note: The other Line raster options are covered 
in the SignCut user manual. 

• With the Engrave lines option selected, the settings are as follows:  

 

 Direction of line pattern: Select from either Horizontal or Vertical: 

   

  

 Density controls how many lines will be generated based on the size of the bitmap. If the number is set 
to the minimum of 1, then in a case like this example, there are so few that the pattern isn’t 
recognizable. At the maximum of 5, the pattern is very clear but takes much longer to generate and will 
take much longer to engrave as well.  

 

                  
 
 
 

 Tool Settings 

o Tool diameter: is the width of the line made by the tool tip as it’s engraving, drawing, foiling, etc. If 
it’s not specified on the particular tool in use, a test line can be made and then measured with a 
ruler or with a caliper. Very thin lines, such as those made with a scratch engraver, may not be 

Direction of line pattern 

Tool settings 
 

Density of line pattern 
 

Select Engrave lines 

Density = 1 Density = 5 Density = 3 

Horizontal Vertical 
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measurable, so testing with a few small patterns first (e.g. try a diameter 0.01” and test larger or 
smaller as needed) will help you determine what works best. 

▪ The difference in the pattern between two Tool diameters is shown here:  

    

▪ Zooming in on the nose, you can see how the pattern differs when the Tool diameter is larger: 

  
 
 

o Tool overlap: this setting helps compensate when the measurement of the tool diameter isn’t 
perfectly measured. It also helps compensate if small amounts of slippage occur on your machine. 
Essentially, the pattern lines are overlapped, by the percentage entered, while being executed so 
that no unintended gaps occur in the fill pattern. 

 
 
 
 
 
 

  

Tool diameter = 0.02” Tool diameter = 0.04” 
 

Tool diameter = 0.02” Tool diameter = 0.04” 
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Appendix A  Troubleshooting FAQ’s 
 
 
 

A1 Communication Issues 

 

I cannot get the Skycut to power on. 

• Make sure the power cable is securely plugged into the adaptor. 

• Make sure the adaptor light is a steady blue light and it is plugged securely into the Skycut. 

• If you still cannot get the Skycut powered on, contact your dealer. 

____________________ 

 

I cannot power off the Skycut. 

• Press and hold the power button until the light shuts off. 

____________________ 

 

I cannot get Wi-Fi to work with my Skycut. 

• Set the Skycut close to the router when performing the initial setup presented in Section 1.12.2.  After 
establishing communication, you can test how far the Skycut can be located from your router. 

• In SignCut Pro’s Settings>Cutter window, make sure you have selected TCP, entered the same IP 
address you selected during setup on the Skycut’s control panel, and have Port set to 8080: 

 

• Make sure your computer is connected to the same router as your Skycut. 

• Verify that Flexi/SignCut or SignMaster/SCAL is the selected software on the control panel under 
Set>Sys Information. 

____________________ 

 

I cannot get USB to work with my Skycut. 

• Unplug/replug the USB cable at both the computer and at the Skycut. 

• In SignCut Pro’s Settings>Cutter window, make sure Output Device / Port is set to USB001: 
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• Try a different USB port on your computer. 

• Verify that Flexi/SignCut or SignMaster/SCAL is the selected software on the control panel under 
Set>Sys Information. 

• Try a different USB cable.  

____________________ 

 

I had to cancel a cut. Now my Skycut is no longer responding when I click on Cut out. 

• Try restarting the Skycut and SignCut Pro. 

____________________ 

 
 

A2 Operating Issues 

 

The control panel isn’t responding very well. 

• Press control panel icons with your finger and not your fingernail. You can also use a black rubber 
stylus. 

• Make sure the control panel is clean. 

____________________ 

My mat is rotating when the Skycut starts to cut! 

• At least two pinch wheels need to be gripping the mat. Move the mat either left or right so that it is under 
two outer pinch wheels and the pinch wheels are aligned under white arrows. Refer to Section 1.09. 

• Make sure you are not trying to force the blade to cut too deeply and/or too quickly through a 
thick/dense material like chipboard or craft plastic.  Slow the speed, decrease the Force, and add more 
passes. 

____________________ 
 
 
My vinyl isn’t feeding evenly while cutting. It starts bunching up on the inside of the end cap. 
 

• Even if you feel the vinyl is aligned properly at the start of the cut, a slight “out of alignment” error will 
become more pronounced with a long cut. When you first drop the pinch wheels, use the arrow keys to 
feed the vinyl for the length of the cut to make sure it is feeding straight. If not, then about half-way 
along the length of the vinyl needed, lift the pinch wheels and realign the vinyl. Continue testing the 
alignment until you can verify that the vinyl is sufficently aligned for the entirety of your project.  

 
____________________ 
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The pinch rollers are not tight enough to hold the vinyl I’m cutting. The vinyl is slipping and rotating when I start 
the cut. 

• The pinch wheels need to be over grit shafts (the dark gray rough areas along the revolving shaft. The 
white arrows will help you align the pinch wheels in correct locations. Also, use outside locations versus 
having, say, one pinch on the far right of the vinyl and a second pinch wheel only in the middle.  

 
____________________ 

 
 
I hear a terrible stuttering sound when trying to cut chipboard (or other thick dense material). 

• That can be a symptom of forcing the blade to cut too deeply and/or too quickly through the chipboard. 
Slow the speed, decrease the Cutting force, and add more passes. 

 
____________________ 

 
 
I’m trying to do a PNC application and the camera can’t read the marks. 

• Make sure you have calibrated the Skycut’s camera. The procedure is covered in Section 3.03. 

• On the control panel, go to Set>Camera and press Set. Make sure the Auto PNC option is marked. 

• If using the cutting mat, make sure the printout is aligned fairly straight on the cutting mat and the mat is 
fairly straight in the cutter.  

• Make sure the blade holder is over the lower right registration mark when starting the cut. 

• Are the registration marks printed dark with no streaking or missing ink?   

• Did you make any changes in the file after printing and before trying to cut? 
 

____________________ 
 
 
The Skycut stopped during a cut. 

• If the Skycut stops with the head over on the left side of the cutter, you have most likely exceeded the 
cutting range. Several things to consider:  

 Check the width of your project. It cannot exceed 16”. 

 Check how far you are moving the head to the left when setting the origin. If your project is 15” and 
you moved the head more than 1” to the left, you will send the cut out of range and the cutter will 
stop. 

• If the Skycut stops and the head is not located near the left side: 

 Make sure it’s not a communication issue. 

 You may have exceeded a buffer limit. Try reducing the number of nodes. In SignCut Draw, select 

the shapes and click on the Reduce number of nodes icon . 

____________________ 
 
 
I’m doing a dual head application but all layers are being executed by the left side. 

• On the control panel’s Home screen, make sure Use Double Head is selected. 

• In SignCut Pro2, in the Cut out window, on the Cutting tab, select D24 from the Choose cutter preset 
menu. 
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• In SignCut Pro, select each color(s) that should be executed on the right side and click on Edit 
Attributes. Make sure Tool 2 is selected. 

____________________ 
 
 

A3 Cutting/Drawing Issues 
 
 
My shapes are drawing (cutting) off the material. What am I doing wrong? 

• When setting the origin, make sure you are using the tip of the blade as the reference point and set the 
tip inside the corner of the material (not too close to an outside edge). 

• Verify that the preview window in SignCut Pro matches where you expect the shapes to cut. 

____________________ 

 

When drawing with the test pen (or cutting with the blade holder), I have extra lines being drawn (or cut). 

• Make sure you raise the pen (or blade holder) in the blade holder seat on the Skycut before tightening 
the screw. The blade holder seat needs to be able to drop the tool down when it reaches the spot to 
start the shape. Otherwise, the tool tip will be dragging across the material from the origin to where the 
shape will begin and then back to the origin at the end of the “cut”. 

____________________ 

 
 
I’m drawing with a pen and there are bubbles at the corners. 

• For perfect corners when using a pen, make sure that Blade Offset and Overcut are both set to 0 in 
the Cut out settings. You do not need an offset for pens (or other tools like embossers and engravers).  

 
 

____________________ 
 

 
My cut started out fine but by the end of the cut, it’s not cutting through the material. 

• Make sure the blade holder housing doesn’t have any bits of material inside of it. 

• Make sure the screw on the blade holder seat is tight so that the blade holder isn’t slipping upwards 
during the cut. 

• Make sure the cutting mat is clean and sticky and the material is pressed down completely, so that the 
material remains stabilized during the cut.  

• Make sure the blade isn’t cutting too deep into the mat. This can sometimes cause the material to be 
pulled up and away from the mat as the blade releases from the plastic it is cutting. 

• Try increasing the cutting force by ~ 5 – 10. 

____________________ 
 

 
My cut is clean in some places but not in others. Why am I not getting consistent cutting? 
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• Try raising the blade holder in the blade holder seat. If the blade is too close to the material, not enough 
force is being applied. Refer to Section 2.01.3, Set the Blade Height Above the Material. 

• Make sure your material is pressed firmly onto a clean and sticky mat (assuming you are cutting a 
material such as paper or cardstock). 

• Your material may require two passes if it’s not homogenous or if it is heavily textured. Sometimes 
intricate shapes also cut better with two passes. 

• Also, if the material has been exposed to humidity, then it will become difficult to cut in one pass.  You 
can dry both paper and cardstock using a blow dryer or in a very low-temperature oven.   

• If you are cutting vinyl without a cutting mat, check the cutting strip to make sure it is still in good 
condition. 

____________________ 

 
I have the outside edges of my chipboard completely taped but I’m not getting clean cuts, even after lots of 
passes. 

• Taping the edges prevents shifting of the chipboard but it’s not enough for stabilizing. You need to 
thoroughly press the entire surface of the chipboard onto a clean and sticky mat. Using a brayer is 
recommended. 

____________________ 

 
I am getting a lot of tearing in my cuts. 

• A number of things can cause tearing so work through this check list:  

 Too much blade is exposed. If you see cut lines in your mat or the backing sheet, shorten the blade 
exposure. You should only be cutting through the material itself.  

 The blade is chipped. Try a different blade. 

 The paper is not adhered well to the mat. Make sure the mat is clean, sticky, and the paper is 
pressed smoothly and evenly on the surface. 

 You may be using too much cutting force. Try reducing it and doing test cuts.  

 You may have too many nodes in the shape. In SignCut Draw, select the shapes and click on the 

Reduce number of nodes icon . 

 The material itself may be subject to tearing, especially on intricate cuts.  Also, if the cardstock has 
been exposed to humidity, then the moisture in the material can make it difficult to cut cleanly. You 
can dry paper and cardstock using a blow dryer or in a very low-temperature oven.   
 

____________________ 

 
I’m cutting very small lettering and the letters are a bit distorted. 

• Verify that you are using the correct Blade Offset. 

• Try slowing down the cut. Small lettering needs slower speed. 

____________________ 

My cut shapes are not the same dimensions as what they are set to in SignCut Pro. 

• Perform the calibration procedure shown in Section 2.08. 

____________________ 

 
My shapes are not completely cutting out. They are still attached to the waste part of the material.  
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• Make sure you have set an appropriate Overcut setting. 

• Make sure the mat is not skewing during the cut. This can happen if even one of the pinch wheels is no 
longer centered under a white arrow.  It can also happen if the speed and/or pressure is set too high. 

 
_____________________ 

 
My cardstock is not cutting all the way through. I have the blade all the way out and using the maximum force. 

• Please refer to Section 1.07.3. It’s important to only have as much blade exposed as is necessary to 
penetrate the cardstock. You may also need to raise the blade tip height (Section 2.01.3). Reduce your 
force back to suggested values for the material you are cutting and do a test cut. 
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